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Preface

Thank you for purchasing Autonics products.
Be sure to read and follow the Safety Precautions thoroughly before use.
This manual contains information about the product and how to use it properly, so keep it in a place
where users can easily find it.

Preface 　 9
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Manual Guide

• Use the product after fully reading the contents of the manual.

• The manual explains the product functions in detail and does not guarantee the contents other than
the manual.

• Any or all of the manual may not be edited or copied without permission.

• The manual is not provided with the product.
Download and use from our website (www.autonics.com).

• The contents of the manual are subject to change without prior notice according to the improvement
of the product’s performance, and upgrade notices are provided through our website.

• We put a lot of effort to make the contents of the manual a little easier and more accurate.
Nevertheless, if you have any corrections or questions, please feel free to comment through our
website.

Manual Guide 　 11
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Common Symbols in the Manual

Failure to follow instructions may result in serious injury or death.

Failure to follow instructions may result in injury or product damage.

Supplementary explanation of the function

Example of that function

Important information about the feature

Common Symbols in the Manual 　 13
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Safety Considerations

Safety Considerations when using USB.
Observe all ‘Safety Considerations’ for safe and proper operation to avoid hazards.

　Warning
1. Do not use the unit in the place where flammable/explosive/corrosive gas, high humidity, direct

sunlight, radiant heat, vibration, impact or salinity may be present.
Failure to follow this instruction may result in fire or explosion.

2. Do not disassemble or modify the unit.
Failure to follow this instruction may result in fire.

　Caution
1. Use the unit within the rated specifications.

Failure to follow this instruction may result in fire or product damage.

2. Use a dry cloth to clean the unit, and do not use water or organic solvent.
Failure to follow this instruction may result in fire.

　Important
1. Follow instructions in ‘Cautions during Use’. Otherwise, it may cause unexpected accidents.

2. Do not connect to a bad USB port. The storage device may be damaged or not recognized properly.

3. If you use multiple USB devices together, they may not be recognized or an error may occur.

4. When disconnecting the USB, remove it safely.

5. If the USB will not be used for a long period of time, disconnect the USB from the PC and store it.

6. Be careful of loss or theft.

7. Do not arbitrarily delete or modify data stored on the USB.

The specifications, etc are subject to change without notice for product improvement Some models
may be discontinued without notice.
For your safety, read and follow the considerations written in the instruction manual, other manuals
and Autonics website.

Safety Considerations 　 15



16 　 Autonics | DAQMaster



AUTONICS END USER SOFTWARE LICENSE
TERMS

IMPORTANT - READ BEFORE OPENING, COPYING, INSTALLING OR USING "DAQMaster" (hereinafter
referred to as, the "Software"). These terms do not prove ownership. These are intended for the usage
approval.
Do not open, load or use this software and any associated materials (collectively, the "Software") until
you have carefully read the following terms and conditions. By loading or using the Software, you
agree to the terms of this Agreement. If you do not wish to so agree, do not open, copy, install or use
the Software.

1. You may not copy, modify, rent, sell, distribute or transfer any part of the Software, except as
provided in this Agreement, and you agree to prevent unauthorized copying of the Software.

2. You may not reverse engineer, decompile or disassemble the Software.

3. The software can be installed on a computer owned by the user who is specified in the software
license terms or who has the genuine key-lock, and for over-installation, the additional key-locks
must be purchased.

4. The Software may contain the software or other property of third party suppliers, some of which
may be identified in, and licensed in accordance with, an enclosed "license.txt" file or other text or
file.

Precautions for using copyrighted works
The use of illegal copyrighted works in the software is prohibited for images, fonts, and sound sources
(hereinafter referred to as “copyrighted works”).
It is prohibited to transfer and use illegal copyrighted works to devices (IPC, PPC, HMI, etc.).
Autonics will not be liable for any damages in the case of using illegal works in the software, and the
users are responsible.

Ownership of Software and Copyrights.
Title to all copies of the Software remains with Autonics or its suppliers. The Software is copyrighted
and protected by the laws of Korea and other countries, and international treaty provisions. You may
not remove any copyright notices from the Software. Autonics may make changes to the Software, or
to items referenced therein, at any time and without notice, but is not obligated to support or update
the Software. Except as otherwise expressly provided, Autonics grants no express or implied right
under Autonics patents, copyrights, trademarks or other intellectual property rights. You may transfer
the Software only if the recipient agrees to be fully bound by these terms and if you retain no copies of
the Software.

AUTONICS END USER SOFTWARE LICENSE TERMS 　 17



When transferring, the entire software must be delivered, and the transferee must agree to all terms
and conditions. In case of breach, the responsibility rests with the transferor and neither Autonics nor
its suppliers assume any warranty or liability.

Limited Media Warranty.
If the Software has been delivered by Autonics on physical media, Autonics warrants the media to be
free from material physical defects for a period of (90) ninety days after delivery by Autonics. If such a
defect is found, return the media to Autonics for replacement or alternate delivery of the Software, as
Autonics may select.

Exclusion of Other Warranties.
EXCEPT AS PROVIDED ABOVE, THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY EXPRESS OR
IMPLIED WARRANTY OF ANY KIND, INCLUDING WARRANTIES OF MERCHANTABILITY,
NONINFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. Autonics does not warrant or assume
responsibility for the accuracy or completeness of any information, text, graphics, links or other items
contained within the Software.

Limitation of Liability.
IN NO EVENT SHALL AUTONICS OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES WHATSOEVER
(INCLUDING, WITHOUT LIMITATION, LOST PROFITS, BUSINESS INTERRUPTION OR LOST INFORMATION)
ARISING OUT OF THE USE OF OR THE INABILITY TO USE THE SOFTWARE, EVEN IF AUTONICS AS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS PROHIBIT EXCLUSION OR
LIMITATION OF LIABILITY FOR IMPLIED WARRANTIES OR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS THAT
VARY FROM JURISDICTION TO JURISDICTION.

Termination of This Agreement.
Autonics may terminate this Agreement at any time if you violate its terms. Upon termination, you will
immediately destroy the Software or return all copies of the Software to Autonics.

Copyright Notice.
This software includes the following open source and is subject to the respective license terms.

/----------------------------------------------------------/
TVirtualStrigTree Copyright ⓒ Soft Gems
SynEdit Copyright ⓒ 2004-2011 Zaharov Michael, EControl Ltd.
Lua Copyright ⓒ 1994-2015 Lua.org, PUC-Rio
BMDThread Copyright ⓒ 1999 -2014 by Boian Mitov
mitov@mitov.com
DragDrop Copyright ⓒ 1997-1999 Angus Johnson & Anders Melander
2000-2010 Anders Melander
anders@menlander.dk
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/----------------------------------------------------------/

Web Site : http://www.autonics.com
E-mail : globaltech@autonics.com

All rights reserved.
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1. DAQMaster

1.1. DAQMaster Introduction
DAQMaster is a comprehensive device management program that provides GUI control for easy and
convenient management of parameters and multiple device data monitoring.
The version of program is divided into general and pro. Pro version supports variety of additional
functions such as user convenience, device and data management as compared with general version.
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1.2. Features
• Multiple Device Support
Simultaneously connect and monitor multiple devices and set parameters.

• Device Scan
In cases of multiple units (with different addresses) connected together, the unit scan function
automatically searches for units.

• Convenient User Interface
Freely arrange windows for data monitoring, properties, and projects.
Saving a project also saves the screen layout.

• Project Management
Saving and loading data as a project file includes added device information, data monitoring screen
layouts, and I/O source selection. Organizing project list makes managing project files easier.

• Data Analysis
Analyses DAQMaster data files (*.duf) or database using data analysis tool by grid and graph. Grid
data can be saved directly to .rtf, .txt, .html, or .csv files in Data Grid.

• Monitoring Data Log
When monitoring, data log files can be saved in either DAQMaster data files (*.duf) or CSV (*.csv) files.
Define log data file naming/saving rules and destination folders to make file management
convenient.

• Tag Calculation Editing
Read tag value is available to calculate the set formula for the desired value.

• Print Modbus Map Table Report
Print address map reports of registered Modbus devices. Modbus map table reports can be saved in
pdf (*.pdf) formats.

• Multilingual Support
Supports Korean, English, Japanese, and Simplified Chinese.
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1.3. Pro Version Features
• Modbus Device Editor

Can add the any Modbus devices which are not supported at DAQMaster to set and monitor the
property and I/O.

• Trigger Event, Scheduler, Action
Conducts preset action by user set condition (Trigger) and time (Schedule) automatically.

• Database
Database managing system turns information into database in real-time, making creation and
management easier.

• Real time log
Makes log file in real time following to the time set by user. Data is saved in CSV file.

• TCP/IP Server
Displays and monitors the communication data through TCP/IP protocol.

• OPC DA
It is Interface method for better compatibility among application programs based on OLE/COM and
DCOM technology of Microsoft. It provides industry standard mechanism for communication and
data conversion between client and server.

• OPC UA
As a communication standard protocol for transmitting data such as sensors or PLCs, various data
can be collected through the OPC UA protocol from the Server.

• MQTT Publisher/Subscriber
Collected data can be published to the broker or subscribed to data from the broker through the
MQTT protocol.

• DDE Server/Client
Supports communication among process embedded in Microsoft Window system (IPC), allowing
application programs to share and exchange information between the applications.

• Modbus Master/Slave
Conducts read and write request from the outside through Modbus protocol.

• Virtual Tag
It is possible to collect user-customized data or transfer multiple data through virtual tag.

• User Manager
Adds account, creates user group, and manages authority of program usage function per each group
individually.
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1.4. Function
Ribbon menu

Ribbon menu Name Description

Project File Creates a new project or open a saved project.
Saves the project file you are working on or save it under a
different name.

Run Logging by connecting or running the device.

View View Sets the panel display and display language.

Window Arrange multiple windows in DAQ space.

Layout Selects the layout of DAQMaster.

Tool Time Display Starts/Stops DAQ, log data, user time, or display the current
time.

Data Analysis Runs the Data Analysis program. Analyze DAQ data file (.duf).
* Supported Analysis Window: Grid, Graph, Vertical Graph,
Alarm Grid, Analysis Space
* Supported Database Chart: Grid, DB Graph

Edit ModBus
Device

Only for Pro version. Runs the Modbus Editor.

User Manager Only for Pro version. Runs the User Manager.

Script Device
Editor

Only for Pro version. Runs the Script Device Editor.

Help Help Runs the Help or check the DAQMaster Update and
Information.
You can check a Pro license.

Project

Name Description

Project List Displays the Project List. You can manage (add/delete) multiple projects by
adding folders.

Project Displays the currently running project and runtime screen. Runs the Project
management program.
When select the Project, you can make settings related to Data File, Log Data
Schedule, When Opening Project in Property.

Runtime Screen Runtime screen registered in DAQ space is displayed as a list. You can delete the
selected Runtime Screen from DAQ space or add it to its properties.
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Name Description

Realtime Log The set Realtime Log related matters are displayed in a list and can be managed
(add/copy/delete).
Runs the log editor and set it. Logging data can be saved as a CSV file, and the
Pro version also supports database.
* Databases supported in the Pro version: Oracle, SQL Server, MySQL, DB2,
SQLite, PostgreSQL, InterBase, Nexus DB, Firebird, Sybase ASE, Sybase ADS, MS
Access, DBF, Advantage, NoSQL Mongo DB

TCP/IP Server Only for Pro version.
DAQMaster performs as TCP/IP Server and exchanges monitoring data with
DAQMaster Client in JSON format. Network data can be displayed in server,
allowing data monitoring.
* Supported features: Monitoring, Security (Login/Protocol), Reading/writing
Tag

DDE Server Only for Pro version.
DAQMaster performs as DDE(Dynamic Data Exchange) Server, allowing
communication among programs in Microsoft Windows system .
* Support items: CF_Text (Format), XL_Table (Format), Server, Client

OPC DA Server Only for Pro version.
DAQMaster performs as OPC DA Serverand can exchange data with OPC clients.
* Supported DA version: 1.0 (Format), 2.0 (Format), 3.0 (Format), Server, Client
* Supported AE version: 1.0 (Format), 1.10 (Format), Client
* Supported UA version: TCP (Format), HTTP (Format), HTTPS (Format), Client

Schedular Only for Pro version.
Conducts preset action by user set time (Schedule) automatically.
* Supported Action: Log Start/Stop, Send to Telegram, Alarm Sound Play, Tag
Error Message/Alarm/Output, Export Report, SMS, E-mail

Trigger Event Only for Pro version.
Conducts preset action by user set condition (Trigger) automatically.
* Supported Action: Log Start/Stop, Send to Telegram, Alarm Sound Play, Tag
Error Message/Alarm/Output, Export Report, SMS, E-mail

Report Only for Pro version.
Prints the data that DAQMaster collects based on the template, type and
interval through the designated path.

MQTT Publisher Only for Pro version.
DAQMaster performs as MQTT Publisher and publish Topics.
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Supported Device List

Name Description

Supported Device Displays a list of devices supported by DAQMaster. Click to add it to my system.
Supports multi-device. Supported device list will be updated continuously
* Pro version Supported device: CCLink IEF Basic Product, DDE Client, Database,
MQTT Subscribe, Modbus Slave, OPC DA Client, OPC UA Client, Virtual Tag, WMI
Manager

My System

Name Description

My System Devices and units are displayed in a tree structure. It support Scan Unit
Address, Read/Copy Parameters, Print Modbus Map Table. When select a Unit,
you can access it from Property
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I/O List / DAQ List / Message

Name Description

I/O List Displays the parameter items of the added device.
Click on the parameter you want to monitor and add it to the DAQ List.

DAQ List Displays added sources in the I/O List.
Once you select a source, you can edit the formula that can calculate the I/O
data.

Message Displays events and log status that occurred during program run.

Runtime Screen / DAQ Space

Name Description

Runtime Screen Selects a Runtime Screen that can monitor data.
* Supported Runtime Data Screen: Grid, Multi Panel, Panel, Line Graph, Bar
Graph, Color Map Graph, Gauge Graph, Histogram Graph
* Supported Runtime Alarm Screen: Alarm History Grid

DAQ Space DAQ Space displays “Runtime screen” and runs the programs of the functions
that the DAQMaster supports.
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1.5. Install / Uninstall

1.5.1. System Requirements
The operating system and computer specifications required to use DAQMaster are as follows.

Operations

Microsoft Windows 7/10/11

Computer specifications

Item Recommended specifications

CPU ≥ Quad Core (Clock Speed by Core ≥ 2.0 GHz)

Memory ≥ 8 GB

Hard disk ≥ 10 GB

Resolution 1024×768 or higher

Others RS232C serial port(9-pin), USB port, RJ45 Ethernet port

1.5.2. Installing the Program
1. Download DAQMaster program at Autonics web page(www.autonics.com).

2. Close all programs before installing DAQMaster. Double-click DAQMaster setup.exe to start
installation.

3. Installer Language window appears. Select the language and click OK  button.

4. If you click OK  button, the “Setup Wizard” window appears in the selected language. Click Next  to
proceed or click Cancel  to stop the installation.

5. If click Next  button, the “License agreement procedure” window appears. Read all the details of the
“License agreement”. After considering the information, click Agree  button to continue the
installation.

6. If click Agree  button, “Installation components” window appears. Choose the components to setup
and click Next .

7. If click Next  button, “Install Location” window appears. Default installation path is already set. If you
need to change the default path, click Browse  button and select the desired destination folder. And
then click OK  to start installation.

8. If click OK  button, installation progress is displayed. Wait until the installation is complete.

9. “Installation Complete” window appears after installation is completed. Click Finish  button to run
DAQMaster. It is possible not to run the program by unchecking the box of Run DAQMaster  and click
Finish  button.
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1.5.3. Installation Folder Structure
After DAQMaster installs completely, total 7 folders are created and programs and all documents are
saved.
If you select the default installation path during installation, a DAQMaster folder is created under
[C:\Program Files\Autonics] as a sub-folder. If you select a new destination folder, DAQMaster folder is
located in that folder.

• Sub-folder: device / document / driver / lang / plugin /sample / tools

1. device

Device folder contains the device information files (*.dev), which can be monitored and set with
DAQMaster. When the program is executed, the files in this folder automatically add related devices to
the program.
If devices are added or upgraded after the program is installed, copy the device information file and
put it into this folder. The list of available devices will be updated. However, if a communication related
function is added or modified, it also changes the contents of the [plug-in] folder. Therefore, changes
may or may not be applied depending on the level of upgrade.

2. plugin

This folder contains core library files (*.dll) for ModBus communications as well as runtime screen files
(*.rpu). The [prop] folder under the [plugin] folder stores library files that have special functions for
each specific device.

1.5.4. Pro License - Connecting USB dongle
1. Plug the USB dongle for DAQMaster Pro license to your PC and run the DAQMaster Pro.

2. The license key is installed automatically. (it may take some time.)

1.5.5. Uninstalling the Program
There are two ways to uninstall DAQMaster.
If you select Remove, a confirmation window will appear. Click Yes  to remove DAQMaster from the
computer.

• Select Start > Program > DAQMaster > Uninstall

• Start > Setting > Control Panel > Add/Remove a Program > Select DAQMaster to remove it
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2. Getting Started

This chapter explains the basic contents in sequence to use DAQMaster for the first time.
For specific information on each function, refer to the related chapter in the user manual.
Device connection, parameter setting and basic monitoring will be proceeded when using TX Series as
follows. After check the contents of instruction manual for the product to connect, apply it to the
following steps.

1. Install DAQMaster program at Master device (ex. PC), connect to the product and run DAQMaster.
Double-click DAQMaster icon on the desktop or select 'Start > Program > DAQMaster' to execute
DAQMaster.

◦ Refer to  1.5.2, “Installing the Program”

2. Open the control panel by clicking 'Support Device List' and double-click the series or model name
to communicate with. When DAQ Interface panel pops up, select the communication port currently
in use and click OK  button.

◦ Refer to  6, Supported Device
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3. Proper communication port setting is needed to connect the device. Select Serial in 'My System'
control panel. In 'Property' control panel, click pull-down icon ▼  on 'communication port' and select
the communication port currently in use.

◦ Refer to  7.1, “My system property”

 

4. In control panel, right-click a newly added 'Support Device name' (TX Series) and click 'Add'.
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5. When 'Add Unit' window pops up, double-click the connected device address to add and then click
OK  button.

6. Click the Connect  button on the 'Project – Run' menu and check the 'My System' control panel. If the
connection is successful, 'Statues' row displays 'Connected'. Click Disconnect  button to unlink the
communication, then continue with setup.
For more information about the default address and setting method of each device, refer to the
manual of the device.
If there is a problem in connection, check the related settings again ‘Communication type /
Communication port’
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7. To monitor the data of the device that user needs, add I/O sources to DAQ List. Double-click I/O
source in the 'I/O List' control panel, then adds to the 'DAQ List'. The added sources are changed to
gray color and displayed in the 'DAQ List'

8. For visualized monitoring, double-click the desired runtime screen in the 'RunTime Screen' and
import to 'DAQ Space'. Imported runtime screen is displayed in the 'Project' control panel as well.
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9. Drag the I/O source to be monitored from the 'DAQ List' and drop it onto the RunTime Screen.

10. Basic settings for monitoring is finished now. To connect the device to DAQMaster, click the Connect
button in the 'Project-Run' menu.

11. To check parameters of the device, right-click either the 'Series name' in the 'My System' or 'address
number', then click 'Read All Parameters'
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12. It is possible to check the progress for 'read parameters' at the bottom of the model in 'Add' row of
the 'My System' control panel. Checking and setting parameter values is available in the 'Property'
control panel.

13. Click the Run  button in the 'Project – Run' menu to record data monitoring and data files of the
device.
It is possible to monitor real-time data and use the data logging function in the DAQ WorkSpace.

14. Click ×  button on the top right corner of the screen to end the program.
Projects are not saved automatically. Please make sure whether the project is saved when close the
program.
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3. Screen

3.1. Ribbon menu
Displays DAQMaster menus by tab.

Project You can create/save or load project files. You can connect the device and Run / Log
/ View Log.

View You can set the panel display and display language. You can set the window
arrangement and DAQMaster layout of DAQ Space.

Tool Various functions are supported using monitored data files. It supports time
display and data analysis, and the Pro version supports Modbus device editing,
user management, and script editor.

Help Run DAQMaster’s help, check update and version information, and the license for
the Pro version.
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3.2. Panel
The panel appears in its default layout. Each panel can be activated by selecting it from the View › Tools
menu.
You can change the position of the panel to suit your environment.
When you drag the title of the panel you want to move, a panel location guide will appear. If you drag
and drop a title onto the guide at the desired location, the panel will move to that location.

Project List It is possible to conveniently open and manage frequently used project files by
adding to the list.
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Project Displays the basic information of the currnet project and the runtime screen.
It is possible to check the status of project management function DAQMaster
supported and execute the program.
Additional settings are possible in the “Property” control panel.

Supported Device List “Supported Device List” control panel shows a list of devices
supported by DAQMaster.
Double-click or right-click a supported device to connect and add it
to My System.
Supported device list will be updated continuously.
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My System “My System” displays devices and units added from the device list in a tree
structure. It is also possible to check and configure connection status.
You can add/change/delete devices and units (addresses) of My System.
You can check details and make additional settings in the ‘Properties’ panel.

I/O List Parameter items that can be monitored for devices added/connected to my system
appear.
When you add the source you want to monitor to DAQ list, the added parameters
are shown in gray.

DAQ List “DAQ List” shows added source lists from I/O list.
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Message Displays and saves events (communication status (start/stop communication,
error), log status (start/stop log), etc.) during running the program.

RunTime Screen Double-click “RunTime Screen” to add it to “DAQ WorkSpace”

DAQ Space DAQ WorkSpace displays “Runtime screen” and runs the programs of the
functions that the DAQMaster supports. The DAQ Space shows each UI and
program screen.
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Property It is possible to check the conditions and change the values of each item in the
“Property” control panel.
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4. Ribbon menu

4.1. Project

1. File
New Creates a new project.

Open From List Opens a project from the project list.

Open Project Opens a saved project.

Save Saves the project you are working on.

Save As Saves the project under a different name.

2. RUN
Connect/Disconnect Connects or disconnects the device and communication.

Run/Stop Starts or stops monitoring data in the connected devices.

Log/Stop logging Saves or stops logging currently monitored data. If you start logging,
log start time and elapsed time are displayed. If you click [Stop
Logging], saving file is available. Files are saved as DAQ Data File
(*.duf) and CSV File (*.csv) format.

View Log Views log data during logging. You can check data between Log
running point and View Log executing point.
If you click [View Log], the data analysis program is activated. For the
information about data analysis program, refer to  11, Data Analysis
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4.2. View

1. View
Tool Brings up a panel window to use the function.

• Property, Supported Device List, My System, Project, I/O List, Run Time
Screen, DAQ List, Message

Language Changes the program language.

2. Windows
Aligns multiple runtime screens diagonally, horizontally, and vertically.

3. Layout
Applies the default layout or executes saving, deleting, and loading user-defined layout.

Default Changes control panels to the default layout.

Runtime Displays the run time screen only.
It is possible to load the hidden control panel at “View-Tool” menu.

Save Layout Saves the current layout.
Click [OK] in the “Save Layout” window and add the user layout.

Delete Layout Select the saved layout and delete it. Click [OK] in the “Delete Layout”
window.

User Layout Displays the control window with the saved Layout.
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4.3. Tool

Time Display Displays monitoring time. If you right-click on the time, you can select
the standard time.

• DAQ Run/Stop, Run/Stop Log Data, User Run/Stop, Current Time

Data Analysis Runs the data analysis program. Allows analysis of DAQMaster data
file (.duf).
For the information about Data Analysis, refer to  11, Data Analysis

Edit ModBus Device Only for Pro version. Runs Modbus Editor.
For the information about Edit ModBus Device, refer to  10.1, “Edit
ModBus Device”

User Manager Only for Pro version. Runs User Manager.
For the information about User Manager, refer to  10.2, “User
Manager”

Script Editor Only for Pro version. Runs Script Device Editor
For the information about Script Editor, refer to  10.3, “Script Editor”
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4.4. Help

Help Opens the help file.

Check Update Checks the version of the program via the internet update server and
automatically updates to the latest version.

License Checks license.
For the information, refer to  1.5.4, “Pro License - Connecting USB
dongle”

About Checks the DAQMaster version.
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5. Project

5.1. Project List
You can manage the project files conveniently by adding frequently used projects like the favorites
menu of the Internet browser.
You can create a folder in the Project List by clicking [Add Folder] and manage saved project files under
the parent folder. You can also change folder/file names as well as add or delete folders/files.
Selecting a folder in the Project List activates Add Folder, Change Name, Add, and Delete menus.
Selecting a project file in the Project List activates Add folder, Add and Delete menus.

Add Folder Adds a folder.

Change Name Changes the name of folder.

Add Adds a project file. Click add opens “Project List” control panel.

Delete Removes selected folder or file.
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5.2. Project control panel
Displays the the currnet project and the runtime screen. It is possible to execute the project
management program.

Project After select the related item, it is possible to set in the “Property”
control window on the right.
For the information, refer to  5.3, “Project Property”

Runtime Screen After select the related item, it is possible to set in the “Property”
control window on the right.
For the information, refer to  9.1, “RunTime Screen”

Project management You can check and execute the conditions of project management
functions supported by the DAQMaster.
For the information, refer to  5.4, “Project Run”
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5.3. Project Property
After click the project name (default: noname) in the “Project” control panel, can change the values of
parameter in the “Property” control panel.

1. Gemeral
It is possible to describe the basic project information such as project name, company name, worker
and other descriptions.

2. Data File
It is possible to set the value of the path of Data Folder, Data File Creation Rules, and CSV Time Type.
Log data files are saved in *.csv or *.duf file format.

Data Folder Sets the path of the folder that project data is saved.

Data File Creation Rules Sets the rules of making file name, format and path of the folder.

CSV Time Type Sets the form of time to be recorded in the log data.
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3. Log Data Schedule
Saves log data at the scheduled time automatically.

Log Data Schedule Sets time of log data to be saved.

Add Adds log data schedule items.
Log data schedule is displayed below
and you can set the log data name on
the top right corner.
The file name of data file creation rule
is displayed next to the data name.

Del Deletes the set items. You can delete
the scheduled item by checking the
left check box and the “Del” button.

Start Time(hh:mm) Sets start time.

End Time(hh:mm) Sets end time.

Spilit Log(hh:mm) Sets split save time.
In case of setting 1 hour 30 minutes, it
saves the file for 1 hour 30 min. and
creates another file to save.

Date Repetition Sets repetition day of week.

OK Saves log data schedule items.

Active Schedule Sets whether to activate log data schedule.
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4. When Opening Project
Run Mode Sets running mode when opening the saved project file.

Layout sets the screen layout (default, runtime, current layout) when opening the
project.
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5.4. Project Run
1. Check the checkbox next to the name of project management in the “Project” control panel whether

activate it.
Select the checkbox. When the phrase of “Run” row is changed as “Ready”, function is activated to
use.

2. Click [Connect] button in the “Project - Run” menu.
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3. Click [Run] button in the “run” tab. The phrase of “Run” row in the “Project” control panel is changed
as “Running” and that function is activated.
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5.5. Realtime log
Executes logging per each I/O following to set cycle and condition.
When double-click [Realtime Log] button in the “Project” control panel, “Realtime Log” window is
opened on “DAQ Space” and it is possible to modify the detail setting.
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Save Type You can select Database or CSV File save type.

Log Name Set a log name.
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Condition Set real-time log conditions.

No condition.

= When selected tag value is equal to the set value, logging
starts.

< Execution when selected tag value is less than the set
value.

> Execution when selected tag value is greater than the set
value.

≦ Execution when selected tag value is equal or less than
the set value.

≧ Execution when selected tag value is equal or greater
than the set value.

!= Execution when selected tag value is not equal to the set
value.

Execution when selected tag value is rising edge, logging
starts.

Execution when selected tag value is falling edge, logging
starts.

Reset Initialize all parameter settings of the Log Editor.

Logging Starts logging when DAQMaster is executed. If “logging” is checked, a file
(*csv) is created in the designated folder and log is written.

Save Interval Set time interval to save log.

File Devision When save type is 'CSV File', set the file devision cycle.
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Information Set database-related matters, file path, tag list information, etc. according to
‘Save Type’.

Database When save type is 'Database', set the 'Database
Connection Info' and 'Table Columns Info'. For the
information about Database, refer to  6.5, “Database”

CSV File When save type is 'CSV File', set the 'File Path
Information' and 'Tag List Information'. For the
information, refer to  5.5.1, “Information Settings”
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5.5.1. Information Settings
Proceed the information settings as below.

1. Click […] button in “File Path Information” to set “File Path Settings: Folder, File Name, File Name
Rule”.

2. Click […] button in “Tag List Information” to set “Tag List Settings”
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3. Click [Add] button in the “Tag List Settings” and add tags.
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5.6. TCP/IP Server
DAQMaster performs as TCP/IP Server and exchanges monitoring data with DAQMaster Client in JSON
format. Network data can be displayed in server, allowing data monitoring.

1. Double-click [TCP/IP Server] in the “Project” control panel to operate TCP/IP server.
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2. Select IP Address item as the currently connected wifi address and click [Config] button to connect
the port. (Default: 5050).
Click [Connect] button to operate TCP/IP Server.

3. The ID and password set in the “User Manager” function allow access to the server. The ID connected
to the server will pop up as a message as shown below.

• For more information about the “User Manager”, refer to the  10.2, “User Manager”

• In “Login User” tab, you can check log-in/log-out time and detailed connection
information of the client users. In “Events” tab, you can see every events related to
logged communication.
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5.7. DDE Server
Performs as a DDE(Dynamic Data Exchange) Server, allowing communication among programs in
Microsoft Windows system and provides protocol or format of instructions and message to
applications. External programs can exchange data of DAQMaster with each other through DDE Server.

1. To open “DDE Server Settings” window appears in the DAQ Space window, double-click [DDE Server]
in the “Project” control panel.

 

2. Enter a each name of “Service” and “Topic” (e.g. Service: DAQMaster, Topic: DAQ) and select and drag
tags to provide to DDE Client from “DAQ List” control panel.
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5.8. OPC DA Server
It is Interface method for better compatibility among application programs based on OLE/COM and
DCOM technology of Microsoft. It provides industry standard mechanism for communication and data
conversion between client and server.

For more information about the OPC Client, refer to  6.8, “OPC DA Client”

1. Double-click [OPC DA Server] in the “Project” window to open “OPC DA Server” window in the
DAQSpace window.

Top-level folder is only available to add folders.
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2. Right-click “OPC Server” and select [Add Folder], then “OPC Server Item” window appears. You can
enter name, description and tag.

3. To add item (sub folder, I/O tag), right-click the added folder and click [Add item].
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4. “OPC Server Item” window appears showing I/O list that is registered to the DAQ List. Double-click
the name of I/O list item to register the name.
You can load the desired I/O item by dragging it from the DAQ List. But, two or more I/O items with
same name are not registered in an one folder.

Register the I/O items with same name is available on the folders with different
locations.

5. To change “OPC Server” running interval, click [Change Interval] button. When “OPC Interval”
window pops up, enter a value of interval.
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6. Above all, click the checkbox next to the OPC DA Server in the “Project” control panel. And check the
phrase of “Run” row is changed to “Ready” to operate OPC Server.

7. Click [Connect] button on the “Project - Run” menu, then “Ready” is changed to “Active” on “Project”
control panel. Click [Run] button in the “Project - Run” menu, then “Active” is changed to “Running”
on “Project” control panel and OPC Server is activated.
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5.9. Scheduler
Conducts preset action by user set time (Schedule) automatically.

1. Double-click [Scheduler] in the “Project” control panel, then “Scheduler” window appears in the
DAQ Sapce.

2. To add a schedule, click  icon and open the “Scheduler settings” window.
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3. Select the date and time to execute an event in the date/time tab.

Schedule type Sets the time delay of the execution after the scheduler starts.

Once Run once when the scheduler starts.

Every day Run every day

Every week Run for every week on certain day

Monthly Run for every month on certain day or week.

Every year Run for every certain year.

Advanced Settings Set repetition interval, repetition period and end date/time.

Repetition interval Sets the repetition interval of the
schedule.

Repetition period Sets the repetition period of the
schedule to be executed.

End date/time Sets the date/time to end repetition
interval of the schedule.

This is an example of advanced settings. Repetition interval and period is 1 hour
and 1 days.
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4. Click “Action settings” tab to set the detailed event of schedule. To add an action, click [Add] button
and then “Action settings” window appears.

Setting an action related to the tag is only available to the I/O items that is added to
the DAQ List. For the method of Adding I/O items to the DAQ List, refer to  8.1, “I/O
List”

Action management

Adds an action. You can set an action name and type.

Modify an action on the list.

Copy an action on the list.

Delete a trigger on the trigger list.

Delete all triggers on the trigger list.

5. Click […] button to open “Action type” in “Action settings” window.

Action type: Refer to the  5.13, “Action” for the details.
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5.10. Trigger Event
Conducts preset action by user set condition (Trigger) automatically.

1. Double click [TriggerEvent] button in “Project” control panel, “TriggerEvent” window is opened on
“DAQSpace”.

AND Trigger If all registered tags meet the criteria, perform an “action”.

OR Trigger If at least one of the registered tags meets the criteria, perform an
“action”.

General Trigger If each single registered tag meets the criteria, perform an “action”
independently.
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2. Drag I/O tag from “DAQ List” control panel to one of the trigger types (AND, OR, General) on
“TriggerEvent” window.

3. Select I/O tag on “TriggerEvent” window and click [Add] button to open “Tag Trigger Event” window.
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4. Input the items in “Tag Trigger Event” by refering to below descriptions.
Click the [Add] button in the action window, the ‘Action Settings’ window appears to add an action.

Trigger name Set the name of trigger.
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Trigger conditions Set the conditions of trigger.

No Condition

= When selected tag value is equal
to the set value, trigger starts.

< When selected tag value is less
than the set value, trigger starts.

> When selected tag value is
greater than the set value, trigger
starts.

≦ When selected tag value is equal
or less than the set value, trigger
starts.

≧ When selected tag value is equal
or greater than the set value,
trigger starts.

!= When selected tag value is not
equal to the set value, trigger
starts.

When rising edge signal is input,
trigger starts.

When falling edge signal is input,
trigger starts.

When the value is maintained
during the set time, trigger starts.

Trigger Value/Tag Enter a value or select a tag to set the trigger.

Static Maintain Time Execute an action after set time.

Check Time When the set trigger condition is satisfied during the set check
time, trigger starts.

5.10. Trigger Event 　 73



Action management Adds an action. You can set an
action name and type.

Modify an action on the list.

Copy an action on the list.

Delete a trigger on the trigger list.

Delete all triggers on the trigger list.

5. Click […] button to open “Action type” in “Action settings” window.

Action type: Refet to the  5.13, “Action” for the details.
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5.11. Report
Prints the data that DAQMaster collects based on the template, type and interval through the
designated path.

1. Double-click “Report” in the “Project” window to open “Report” window and click the [Add] button
to open “Report setting” window.

To use “Report export” action, It is needed to set the “Report” function first.
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2. Editing template, print out path, type, start and end time, print interval and etc is available. Set the
items and click the [Setting] button to open “Database Settings” window.

3. Enter the details of Database server and click [Next] button. If the connection is successful,
Table/field settings appears and downloads table and value of timefield. Select the desired field item
and click [OK], then DB setting is completed.
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4. After the report setting is complete, list is added to the report window as below. You can check the
created report by clicking the [View Report] button.
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5.12. MQTT
MQTT is a protocol designed to enable communication with minimal power and packet in
consideration of limited communication environments, optimized for M2M (Machine To Machine) and
Internet of Things (IoT).
MQTT consists of a “Broker, Publisher, Subscriber” structure, not a “client - server” structure such as
HTTP, TCP, etc.

“Publisher” publishes, “Subscribers” subscribe to “Topic”, and “Broker” relay them. This is useful for
1:N communication because multiple subscribers can subscribe to a single Topic.
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5.12.1. Mosquitto (MQTT Server/Broker)
Mosquito is an MQTT open-source message broker program that is light and supports most essential
functions.

1. Install and test

1. Download and install the installation file from the Mosquito manufacturer’s website
(http://mosquitto.org).

2. Check the executable files below in the installation folder.

mosquitto.exe Mosquitto Server/Broker

mosquitto_sub.exe Mosquitto client for subscribe

mosquitto_put.exe Mosquitto client for publish

3. Run the “Command Prompt” and navigate to the path where the program is installed, enter the
command below and check the Topic output.

Command mosquitto_sub -h test.mosquitto.org -t "#" -v

Topic print
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2. Setting

When installing the Windows version, the Mosquito service runs automatically at boot time. If the
service is in operation, manual server will not work.

1. Double-click “Mosquito Broker” in “Control Panel - Administrative Tools - Services” to open
“Mosquitto Broker Property” window

2. In general tap, change the value of start item “Manual” and “Service status” to “Stop”.
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3. Run

Run the “command prompt” in administrator mode and move to the installation folder to input the
commands below.

Server (mosquitto) · Command: mosquitto -v
· Running screen

Publish (mosquitto_pub) · Command: mosquitto_pub -h localhost -i testPub -t debug
-m "TESTNG"

· Command

-h Specify sever

-i Specify Client ID (omitable)

-t Specify subscription topic

-m Specify publishing message

Subscribe (mosquitto_sub) · Command: mosquitto_sub -h localhost -i testSub -t
/DAQMaster

For more detailed instructions and instructions, refer to the manufacturer’s website
(http://mosquitto.org).
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5.12.2. MQTT Publisher
1. Check the MQTT Publisher entry in the “Project” control panel and double-click to launch the “MQTT

Publisher” and click the [Settings] button at the top to open the “MQTT Publisher Topic Settings”
window.
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Address Address of broker server

Port Port of broker server

Interval Communication interval

User Input the user ID that set on the broker server

Password Input the user password that set on the broker server

User define Uses user-specified data formats and separator.

· Default

tag name = tag.name
tag value = tag.value
tag time = tag.time
separator = %
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2. Right-click the topic item in the “MQTT Publisher” settings window, select [Add Topic] to open the
“MQTT Publisher Item” settings window, create each item, and click the [OK] button.

Topic name Name of Topic to publish

Description Description of Topic to publish

Tag Select a tag to register with Topic.
An added tag can be registered to the “DAQ List” by dragging to the topic
time in the “MQTT Publisher” window.
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3. Click the [Connect] button on the Project - Run menu to try to connect to the broker server and
display the results at the bottom. After connecting, clicking the [Run] button initiates monitoring and
sends the value of the registered tag to the server.

Refer to  6.6, “MQTT Subscribe” for the details about MQTT Subscribe.
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5.13. Action
This function is executed when the conditions set in “Trigger Event” or “Scheduler” is met.

Start log starts the log function.

End log stops the log function.

Send a telegram message sends a telegram message. For more information about the
telegram settings, refer to  5.13.1, “Telegram message
setting”

Play alarm sound plays the selected sound file. Select [Open] button to choose
desired sound file and click [OK] to apply it.
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Tag Out Outputs user-defined value to the specified tag in the “Tag Out”
Settings.
Click [Tag list] and select the desired tag. And enter the value to
the “Value” and click [OK] to apply it.

Tag error Outputs the user-defined tag error to the specified tag.
Click [Tag list] and select the desired tag. And click [OK] to apply
it.
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Tag alarm prints the user-defined tag alarm to the specified tag.
Click [Tag list] and select the desired tag. And click [OK] to apply
it

Send SMS text message Sends a telegram message.
For more information about the telegram settings, refer to
5.13.2, “SMS text message setting”.

Send email message Sends a telegram message.
For more information about the telegram settings, refer to
5.13.3, “Email message setting”.

Export csv file Saves tag information to csv file in the selected path.
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Report export Export the one of selected report file which is set by “Report”
function.
For more information about the “Report”, refer to  5.11,
“Report”.

Realtime log Runs the real time log which have already set.
For the information about realtime log, refer to  5.5, “Realtime
log”.
Select realtime log name on the list and click [OK] button.
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Parameter write Writes a preset value for the specified parameter.
In the “Parameter” window, select the desired parameter, enter
the channel and the desired value to the “Parameter Value
Setting” window, and click the [OK] button.

Reset value Initializes the selected tag value.
Click the [Tag list] button to select a tag and click the [OK]
button.
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5.13.1. Telegram message setting
Telegram is a nonprofit open source internet messenger, available in diverse operating system such as
Android, iOS, Window, MAC and Linux. It provides users with source code, encouraging them to
develop desired functions with the messenger.
By the Bot, virtual conversation contact, when tag value matches the set condition, Telegram message
is sent to the designated person. (Internet connection is required.).
By telegram functions, you can share the massage to the other groups and search the messages. Please
refer to the telegram usage. (Android and iOS system have an identical setting process. This manual
explains with Android)

1. Search “Telegram” at the Android Play store and download the application.

2. You have to create and register a virtual robot called Bot to receive messages from DAQMaster. In the
telegram (at the upper the magnifying glass icon), search and select @Botfather.

3. Click [Start] button of the display as below.
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4. Enter ‘/newbot’ in the chat window.
According to the BotFather message, name a Bot name, Bot user name (must end with “bot” or
“Bot”). User name is a name that identifies at the telegram, if the other named the designated name
already, it is not used in duplicate.
(E.g. Bot name: Autonics, user name:at_androidbot)

5. Then you are provided with address to chat with the created Bot and token. Token is as same
function as the serial number or register code, so it is essential to find chat groups and send
messages. Click the given address to join chat with the Bot.
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6. Click [Start] at the button of the display. One or two times of message are necessary prior to
receiving message from your Bot. If you do not send the messages, the group may not be searched.

 

7. In the DAQMaster, double-click “Send a telegram message” in action type to open “Telegram setting”
window. Enter the token issued in 5th step to the “Token” item and click [Find a message groups]
button.
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8. Check the desired receiver, select chat to use and choose alam message format among “Time”, “Tag
Name”, “Present Value” and “Screem Image”.
After entering test message in the bottom blank, click [Test] button.

9. Message is delivered to Telegram.
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5.13.2. SMS text message setting
Send an SMS text message to the designated address with tag information

1. Click [Set] button in the “Set caller information” item and edit SMS transmission medium, SMS ID
and SMS Password and then click [connect] button. Edit caller’s phone number at the “Caller’s
mobile number” and click [OK] to save it.
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2. Click [Add] button in the “Set caller information” item and open “Set recipient information” window.
Click [Tag list] button to select the desired tag. And select message type to send. (Time, Tag Name,
Present Value)
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3. Click [Send text messages (test)] to check whether the message is properly sent or not.

The cost is at the caller’s expense.
Only short messages can be sent and only one destination can be set.
Depending on the text message service provider, overseas receiving may be restricted.
For more information, contact the SMS text service provider.
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5.13.3. Email message setting
Send an email to the designated address with tag information.

1. Enter the “Login information” and “Received information” in the “Email settings” item.

2. Click [Tag list] to select the desired tag and select Message type (Time, Tag Name, Present Value) and
Attachments.
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3. Click [Send email (test)] to check whether the message is properly sent or not.
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6. Supported Device

6.1. Supported Device List
“Supported Device List” control panel shows a list of devices supported by DAQMaster.
You can double-click or right-click a supported device to connect and add it to My System.
Supported device list will be updated continuously.
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6.1.1. Add Device
1. If you double-click a name of series/model or click the device expand button [+] in the “Supported

Device List”, supported device list will appear.
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2. When selecting a device, you can see the basic information about the device in the “Property”
control panel as follows.

3. Select the series/device name (TX Series) you want to add to “My System”. Double-click or right-click
the selected device and click [Add to My System] to add the device.

Refresh Updates “Supported Device List” control panel when device files
(*.dev) are added.

Add to my system Adds device to My System to communicate.

Expand all Shows the list of all supported devices.

Collapse all Hides the list of all supported devices.
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4. Select Serial or Ethernet on the new “DAQ interface” and click OK  or double-click the interface.
You can modify the configuration of the added Serial or Ethernet in properties.

5. If there is another devices added earlier, you can see added “Protocol-Port Name” on the Added DAQ
Interface.
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6.1.2. UDP SCan
1. Devices that support UDP scanning can select 'UDP Scan' in the interface selection window.

2. Select UDP Scan and click OK button or double-click, "UDP Scan" window pops up.
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3. Press the start button to proceed with UDP scanning.

4. Select the scanned unit to add the device to “My System”.
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6.2. Miscellaneous (User-defined device)
You can add or edit the miscellaneous devices which are not supported at DAQMaster.

6.2.1. Add User-defined device
1. Double-click the device type of “Miscellaneous” in “Support Device List” control panel and add it to

“My System”.
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2. When “DAQ Interface” window pops up, select the currently used interface and click OK .
(If there is no selectable option, this step is skipped)

3. When selecting the device name in “My System” control panel, [Add] button is enabled. To add a unit
(address), click the Add  button in upper

4. Select each item in “My System” control panel to check and edit the detailed information in
“Property” control panel.
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6.3. CCLink IEF Basic Product
DAQMaster performs as a master of CC-Link Field Basic device, supporting I/O monitoring and the
function outputs the tag.

CC-Link IE Field Basic Device: HMI, I/O Unit, Inverter of Mitsubishi Electric.

6.3.1. Add Slave Device
1. Add the “CCLink IEF Basic Product” to “My System” control panel and right-click it. Click the Slave

setting  button to open “CCLink IEF Basic slave setting” window.

2. When “CCLink IEF Basic slave setting” window pops up, click Add  of “Group list” to add a group.

3. In “Group setting” window, enter “Name”, “TimeOut”, “TimeOut count” and “LinkScan Time” (check
a checkbox to use) to add a group.
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4. In “Slave list” window, click Add  to add a slave device.

5. When “Slave setting” window pops up, enter “Name”, “IP address” and “Occupied number” and click
OK  to add a slave device.
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6.3.2. Add Slave I/O
1. After adding “IEF Basic Product” to “My System” control panel and add “Slave device”, right-click the

added CCLink IEF Basic Product and select “I/O setting”. Then, “CCLink IEF Basic I/O Setting” window
pops up.

2. Select an item of “Slave I/O List” and click Add  to add, then “Add Slave IO” window pops up.
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3. Check the descriptions of the items and fill out the items in this window. Click Add  to add a slave I/O.

Group number Select group number.

Slave IP Select the added slave IP address.

Name Enter I/O tag name.

READ/WRITE Select I/O type either READ or WRITE

Data type RWr / RWw: Word type (memory allocation: 64Byte),
RX/RY: Bit type (memory allocation: 8Byte)

Offset I/O Offset

Size Size × 1Byte

High/Low Select Little-endian or Big-endian, when the size is 1.

Unit Unit of I/O tag

Description I/O description

I/O Optional input Automatically set by clicking I/O offset.
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6.3.3. IP Setting
It is needed to set Master IP address and Slave IP address on the same network router.
When a range of Master IP is from x.x.x.1 to x.x.x.255, a Slave IP should be set in the range from x.x.x.1 to
x.x.x.255. (set a Slave IP address excepts for the Master IP.)

• The example of IP setting
In case the Master IP address is 192.168.3.250,
Slave 1 IP is 192.168.3.1
Slave 2 IP is 192.168.3.2
Slave 3 IP is 192.168.3.3

6.3.4. Cyclic Transmission ON/OFF
This function features the constant packet transmission among the connected devices on the same
network
In the “My System” control panel, right-click the added “CCLink IEFBasic Product” and select [Cyclic
Transmissions ON/OFF] to on/off this function.

6.3. CCLink IEF Basic Product 　 113



6.4. DDE Client
DAQMaster performs as a DDE Client, connecting to DDE Server and data communication.

Refer to the  5.7, “DDE Server” for the details about DDE server.

1. Add the “DDE Client” to “My System” control panel and select it. To add the unit, click Add  button.

2. Select the added unit, and click the …  button next to the “Setting” in the “Property” control panel to
open “DDE Client Configuration-1” window.

3. For connecting DDE Server, enter the “Service” and “Topic” values of DDE Server to “DDE Client
Configuration-1” window. Click the Add  item to open “DDE Item” window.
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4. Enter a value for each item and click the OK  button.

Item Name Enters the name of DDE Server item.

Description Enters description of the item.

Unit Sets data unit.

R/W R Reading is only available.

W Writing is only available.

R/W Reading and Writing are available.

Type Set method of data display.

Decimal Point Set decimal point.

List Displays item list.
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5. Below is when two items are added.

6. Check the added item at I/O List and it is available to be added to DAQ List.

7. At runtime screen, monitoring is available by various graph types.
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6.5. Database
Database managing system turns information into database in real-time, making creation and
management easier.

1. Add the “Database” to “My System” control panel and select it. To add the unit, click the Add  button.

2. Select the added unit, and click the …  button next to the “Settings” in the “Property” control panel to
open “Database Settings window.
Set the Provider, Server, Port, User Name, Password and Database type, and click Next  to connect the
server.
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3. If the connection with the server is successful, “Database Table Settings” window appears. You can
select a table to be added and click [Add] button to edit the database. When the settings is complete,
click Next .

4. Select “Save Type” and “Time Field” in “Database Time Field Settings” window.
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5. Set the database field and click OK .

6. After the settings is complete, executes “Realtime Log”, then the information about database
connection is displayed and …  button of “Table Columns Info” is activated.
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6.6. MQTT Subscribe
Explains instructions for adding subscribe of MQTT protocol communication.

For information related to MQTT protocol and Publisher, refer to the  5.12, “MQTT”.

1. Add the “MQTTSubscribe” to “My System” control panel and select it. To add the unit, click the Add
button.

2. Select the added unit, and click the …  button next to the “Configure” in the “Property” control panel
to open “MQTTSubscribe” window.

 

3. Click Settings  button to open “Comm Settings” window.
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4. Enter the value by refering to the below description per each item, click OK  button.

Host Address of broker server

Port Port of broker server

Client Name of a client which connect broker server

User, Password User ID and password set by broker server

Address and port are required. Enter the user ID and password as the value set by
the broker server, and leave blank if it is not set.

5. Click the Connect  button on the “Project - Run” menu to try to connect to the broker server and
display the results at the bottom.
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6. When connecting successfully, right click the topic item and click Add Topic  button to open “Topic”
window. Enter topic name to receive from MQTT broker and description in the “Topic” window, and
click OK  button.

7. When clicking [Load Tag Information] on connecting status, the list of tags is loaded.

The [Load Tag Information] button is disabled while data is being loaded after
clicking. If there is no data to load, the button is reactivated after 5 seconds, and
“No tag information received” message is printed.

8. The added tag can be found in the “I/O List” control window and can be added to “DAQ List” or
monitored by the runtime screen.
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6.7. Modbus Slave
DAQMaster performs as a Modbus Slave responding to the reading and writing requirements. It
supports Serial, Ethernet interface and RTU, ASCII, ModbusTCP Protocol.

1. Add the “Modbus Slave” to “My System” control panel and select it. Set “Mode” and “Start Address”
in “Property” control panel.

2. Select added “Modbus Slave” in “My System” control panel and click the Add  button to add the unit.
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3. Right-click the added slave unit address in “My System” control panel and click “Edit Address Table”.
Or click …  of “Edit Address Table” of “Property” control panel and open “Edit Address Table”
window.

4. Click [Add] button on the top of the “Edit Address Table” window, then “Edit Address” window pops
up. In “Edit Address” window, setting the detailed information on the slave device is available. Edit
the value of these items and click OK  to set up.
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The added I/O tags from “Edit Address” are added automatically to the I/O List.

5. Click Copy  button of “Edit Address Table” window to copy the added item. Click Import  / Export
button to import and export the csv file.
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6.8. OPC DA Client
DAQMaster performs as a OPC Client, transmitting collected data to the connected OPC Server.

For more information about OPC Server, refer to  5.8, “OPC DA Server”

1. Add the “OPC Client” to “My System” control panel and select it. To add the unit, click Add  button.

2. Select the added unit, and click the …  button next to the “Setting” in the “Property” control panel to
open “OPC client Configuration” window.
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3. Click ▼  button at OPC Server to select the desired OPC server.

4. When selecting OPC Server, OPC server path is displayed as list. Double-click OPC server path or click
→  button, the path is added at I/O List.

5. It is possible to add or delete OPC server path by “Add, Delete, Delete All” of upper menu of I/O List.
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6. Check the added path at I/O List and and it is available to be added at DAQ List.

7. At runtime screen, monitoring is available by various graph types.
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6.9. OPC UA Client
DAQMaster becomes the OPC UA Client and sends the collected data to the accessed OPC UA Sever.

1. Add the “OPC UA Client” to “My System” control panel and select it. To add the unit, click Add  button.

2. Select the added unit, and click the …  button next to the “Config” in the “Property” control panel to
open “OPC UA Client” window.
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3. Click the [Select Server] button to open the “Select OPC Server” window. To search for a server that
matches certain criteria, enter the address and port number in the “Discovery server” and click the
Find  button. It is possible to enter the full address of the server in the “Url” on the “Server” tab when
knowing it.
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4. Security mode related settings are available on “Security” tab of the “Select OPC Server” window.

The “User” tab allows settings related to user authentication.

The “Proxy” tab allows entering the Proxy server path and information.

5. If the connection is successful by searching for a server or entering a full address, the server’s folders
and files appear in the “Address space” entry in the “OPC UA Server Settings” window.
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6. When selecting the item in “Address space”, the properties appear in “Item Property” window.
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7. Double-click the item in the “Address space” to open the “OPC UA Client Item” window. Enter the
contents of each item and click the OK  button to add it to the I/O.

6.9. OPC UA Client 　 133



6.10. Virtual Tag
Connects multiple READ type tag values and apply formulas to a virtual tag to obtain the desired form
of data, or enter data into a virtual tag to transfer that data to multiple WRITE type tags.

1. Add the “VirtualTag” to “My System” control panel and select it. To add the unit, click Add  button.

2. Select the added unit, and click the …  button next to the “Configure” in the “Property” control panel
to open “VirtualTag” window.
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3. Right click “VirtualTag” item and click Add Tag  button.

4. Enter name of virtual tag, type of R/W, description of tag in “Virtual Tag Item” and click OK  button.

5. Drag the device tag from “DAQ List” control panel.
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6. To apply the formula, right click the added virtual tag item and click the [Edit Formula] button.

7. In the “Edit Formula window”, click the Template  button to edit the formula. Check the check box
next to “Apply” to apply the formula immediately and click the Save  button to save the formula.
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8. To transfer data of virtual tag to other tag, create a virtual tag of a write property. In the “Virtual Tag
Item” window, select “W” as the setting value of “R/W” item and click OK  button.

9. Select the generated virtual tag name of a write property, enter the value in the “Write - Value” item
in the “Property” control panel.
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6.11. WMI Manager
This function features that DAQMaster accesses and shares the managament information in the
network using the Window Standards. It is able to collect and show the system configuration.

1. Add the “WMI Manager” to “My System” control panel and select it. To add the unit, click the Add
button.

2. Select the added unit, and click the …  button next to the “Configure” in the “Property” control panel
to open “WMI Configure” window.
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3. Click Connect  button to monitor local CPU load. When connecting is completed, items such as CPU
Usage, Total Memory, Free Memory appears in the Query list.

4. Double-click item to open setting window to monitor and click OK  to add it to the tag item. It is
possible to delete “WMI item” by using Delete  and Clear  buttons.
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5. Double click the “User Query” to preview customized WMI query format.

  

6. Added query items to source list are registered automatically in I/O list. The items can be listed in
DAQ list like another I/O source.

7. You can monitor selected query items at the runtime screen in various kinds of graph style.
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7. My System

“My System” control panel displays device and communication interfaces added from the “Support
Device List” control panel in a tree structure as well as connection status. You can also add, change and
delete device units.

 

Select enable/disable by checking check box on the left side of items.
It is possible to set or modify by selecting an item in “Property” control panel.
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Select the protocol (Serial, Ethernet etc.) modify communication related items in the
“Property” control panel.

Select Modbus Master check the information about Modbus Master
and set the preferences in the “Property”
control panel.

Select the device name (TX Series) check the information about the connected
device in the “Property” control panel.

Select Unit (1) displays parameter information of the
connected device in the “Property” control
panel.

Connects a device to multiple communications ports.
Some of the communication-related items are able to be changed in “Disconnect”
status only.
For more information about setting properties of each parameter, refer to  7.1, “My
system property”.
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7.1. My system property

7.1.1. Serial
It is possible to change the Serial related settings. Click Serial in “My System” control panel and check
the “Property” control panel.

 

The “Property” control panel displays the information about the communication port currently in use.

Search Port List Fix Init List Loads communication port list of computer
at the time when Serial is added, saves it to
the port list and then fixes it.

Auto Search Rearranges the port list automatically
when it is changed.

Communication Port Shows available COM Ports and can select it. Set the connected COM
Port.

Baud rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, 115200bps

Check Parity Selects the parity bit for communication.
(none, odd, even, mark, space)

Stop Bit Selects the stop bit for communication. (1, 1.5, 2)

Bit per Byte Selects Byte Size. (5, 6, 7, 8)
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Hardware None, RTS/CTS

Software None, XON/XOFF

DTR Control Disable, enable, handshake

RTS Flow Control Disable, enable, handshake. toggle

Byte Time Sets transfer interval of packet per byte.
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7.1.2. Ethernet
Sets Ethernet protocol for communication. Select the Ethernet in “My System” and check “Property”
control panel.

 

“Property” control panel displays information about the communication port currently in use. The
name that is displayed in “Property” control panel can be modified by clicking “Name” in “Property”
control panel.
Refer to the following table to check the “Configuration” items.

Socket Type Client Sets as Client Mode.

Server Sets as Server mode.

Address Enters the designated IP Address from the main device.

Port Sets port number.

Connection Timeout Sets the time of the timeout for connection.

Client Type Non-Blocking Progresses next transmission
without the response.

Blocking Progresses next transmission after
receiving response.
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Auto Connection Mode Use Attempts to reconnect when Ethernet is
disconnected or connection failure
occurred for the first time.

Not Used Not use auto connection mode.

Auto Reconnection Interval Sets interval time of Auto Reconnection.

Alive Status Attempts to reconnect after receiving the error massage
(Timeout, Echo) from Ethernet Server without disconnection.

Check Alive Interval Sets check cycle of the Alive status.

Auto connect retry count Sets the number of retries for Auto connection.
When set to '-1', infinite automatic connection Proceed with
retry. (-1 to 100)
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7.1.3. Modbus Master
Can change protocol related setting for ModBus. After selecting “ModBus Master” and clicking “[…]” of
the “Property” control panel, “ModBus Master” window is opened

 

1. General

'Modbus Master Communication Test' and 'Calculate CRC16' functions can be performed.
Next to the ‘Information’ item in the ‘Properties’ control window When you click “[…]” the button, the
‘Modbus Master’ information screen appears.

ModBus Master Communication Test Conducts the test to check whether the
communication is normal. Enter the
“Communication Test” tab, and click [Test] button
to execute communication test.

7.1. My system property 　 147



Calculate CRC16 Verifies the protocol by CRC16. Input the Hex data to
“Data” section and click [Calculate CRC16] to
convert CRC16 data.

2. Configuration

Mode RTU, ASCII, ModBus TCP

Timeout Set the timeout time.

Retries Set the number of retries. When set to '-1', infinite automatic
connection Proceed with retry. (-1 to 100)

Number of Length Byte You can choose the data byte length. (1,2)
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7.1.4. Device
Click the device name in “Name” of “My System” control panel to see basic device information in
“Property” control panel.
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7.1.5. Unit Address
Click the connected address number in “My System” control panel to see detailed device information.

Device Name Displays device name.

Unit Address Displays unit address.

Model Displays Model name.

DAQ Repeat Interval Sets the repeat reading cycle for the I/O source when running the
connected unit. (0 to , default value: 1000 msec)

Frame Interval Sets the Frame reading cycle. (4 to 5000 msec, default value: 40 msec)

User Unit Name Sets the user unit name.

Version Displays HW(Hardware)/ SW(Software) version of device.
If the firmware versions of connected devices are different, extra
settings may be required for normal operation.
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You can check and modify device parameters by reading parameters while devices are
connected.
For the information about reading parameters, refer to  7.9, “Read All Parameters”

Example of setting the DAQ Interval to 1000 msec and adding 4 I/O sources to DAQlist.
When the number of I/O do not exceed the Repeat Interval value(1000 ms), the
program brings data base on the cycle.

When a large number of I/O sources are added, data reading cycle may exceed the
defined Repeat Interval, as shown above.
As a result, if actual I/O data reading time exceeds the set “DAQ Repeat Interval” set
value(time), the program and the units communicate on the minimum time interval
required to read all I/O sources.
If the environment requires a precise set value and rapid repetition interval, add Serial
port(s) and split the device connection.
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7.2. Adding a Unit
This is used to connect few of devices or when you know the address number of each unit.

1. When selecting the device name in “My System” control panel, [Add] button is enabled. To add a unit
(address), click the [Add] button in upper menu, or right-click the device name and select [Add].

2. Select address number, Double-click or use [>] button to add, and click [OK] button.
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3. You can see the unit (address: 1) added under the device in My System after click [OK] button. If you
want to add multiple devices, click [Add] button. (Up to 99 devices can be added.)

4. When selecting the unit address (1), [Change] button is activated. To change the unit address, click
the [Change] button on menu or right-click and select “Change”

5. If you click [Change] button, the current address (1) highlights in yellow. Select a new address and
click [OK] to change the unit address.

Unit (address) cannot be deleted, changed or added while the status is “Connect”
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7.3. Scan Unit Address
“Scan Unit” features scanning multiple connected device units or adding the units you does not know
the address number per each unit.

1. Click [Connect] button on the “Project – Run” menu to connect.

2. Right-click the series name (ex. TX Series) in “My System” control panel and click the “Scan Unit
Address”.

3. When “Scan Unit” window pops up, click [Start Scan] to start.
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4. All desired units are listed in the window, click [Stop Scan] to stop scanning and select the Unit. Click
[OK] button to add it to the “My System”.

5. If “Status” rows are marked as “Connected” in “My System” control panel, the connection status is
normal. Click [Disconnect] to disconnect, and go on the settings.
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7.4. Read All Unit Parameters
Read all unit parameters allows you to save and copy parameters.
After selecting the device in my system, right-click and execute ‘Read All Unit Parameters’.

156 　 Autonics | DAQMaster



7.5. Save and Copy parameters

7.5.1. Save parameter values
When several same model units cannot be connected to DAQMaster at once and parameter copy is not
available, you can save the setting of the device as a file and utilize the file at a later. If the firmware
version of the devices are different, parameter copy function may not be available. Following
explanation is based on TK.

1. Connect the TK device which parameters are saved.

2. Click “Read All Parameters” of the unit device which parameters are saved or “Read All Unit
Parameters” of TK at My System.

 

3. Select TK at My System and right-click to select “Copy Parameters” and Parameter Copy dialog
appears.
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4. Right-click the unit which parameters are saved and select “Parameter Select”. The parameter values
of the unit is loaded at the right side of the dialog.

5. Click “Save” and it saves parameters in *.prx file.
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7.5.2. Copy parameters
To connect the several same model units at once, you can copy the parameters. You can copy the saved
parameter file to the other devices(target units).

1. Same orders 1st to 3rd of the Save parameter values.

2. Check the units to be copied at the check box of the left side of the dialog.

3. Click “Open” and select the parameter file and it loads at the right side of the dialog.

4. Click “Copy” and copy is progressing. “the Process of Copying data” text appears at the right side of
the dialog.

5. After completing copy, “Copy Complete!” dialog box appears. Click “OK” and copy is finish.

Depending on the device series or device firmware version, the above features may
not be supported.
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7.6. Print Modbus Map Table
This feature outputs ModBus map table of a device, which uses ModBus communications, as a report.
Direct print out is available and you can save in a PDF File (\*.pdf) format.

1. In the status that a device is added, right-click the device in My System and Select Print ModBus Map
Table from the pop-up menu.

2. In the preview window, setting Print, Print, and save are available.
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7.7. Parameter mask Settings
This feature is able to hide unnecessary parameters to user environment or less frequently used
parameters in parameter group.
Masked parameters are not only displayed. The set values of masked parameters are applied.

This function is only available for TK, TF3, KPN, and TN Series products. Since the
parameters supported by each product are different, please refer to the instruction
manual for each product.

1. Right-click the unit for which you want to set the parameter mask and select ‘Parameter Mask
Setting’.

Parameter mask selection Select the to-be masked parameters.
Right-click the to-be masked parameters and they turn gray.

Download Applies the set masked parameters to the device.

Save Saves the set masked parameters as a mask information file.

Open Opens the saved mask information file.
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Initialize factory default Clears the set for the masked parameters.
Download this setting to apply it to the device.

Close Closes the Parameter Mask Settings dialog.

Device information Displays device name, unit address, model name, and version.

Example of masking alarm, SV setting parameters of parameter 1 group, input type,
unit of parameter 3 group, and all of parameter 4 group.
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7.8. User Group Settings
This feature is able to set the frequently used parameters to the user parameter group. You can quickly
and easily set parameter settings.
User parameter group can have up to 30 parameters.

This function is only available for TK, TF3, KPN, and TN Series products. Since the
parameters supported by each product are different, please refer to the instruction
manual for each product.

1. Right-click the unit for which you want to set a user group, and then select ‘User Group Settings’.

User parameter group Displays the selected parameters as user group parameter
Double-click the parameters for the user group, and these
parameters turn gray.
To delete the parameters at the user group, double-click the
parameters.

User group selection All initialize Initializes the set user group.

↑,↓ Changes the selected parameter order
up/down.

Download Applies the set user group to the device.
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Save Saves the set user group as a user group information file.

Open Opens the saved user group file.

Initialize factory default Clears the set for the user group.
Download this setting to apply it to the device.

Close Closes the User Group Settings dialog.

Device information Displays device name, unit address, model name, and version.

Example of the set user group with SV setting, control output RUN/STOP, SV-0/1/2/3
set value, manual reset, input Bias, alarm output 1 mode/type/hysteresis/NO/NC/ON
delay time/OFF delay time parameters.
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7.9. Read All Parameters
To edit a parameter of a connected unit in DAQMaster, it is needed to load parameters of the connected
unit.

1. Select “Unit address number” in “My System” control panel and then right-click it to execute the
“Read All Parameters”.
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2. When the reading is completed, the “Property” control panel displays the parameters. Checking and
changing parameter is also available.

• If you only want to monitor parameter without editing, click [Run] button on
“Project – Run” menu.

• When parameter values are changed in the “Property” control panel, changed
values are immediately applied through communication with the device.

• During a parameter value change, all property values are displayed in gray (not
modifiable). After changing, they are restored to the original color.

• To apply the changed value, change the value and press Enter key (for edit type), or
select an item with the mouse or the Alt + arrow keys, and press enter (for list type).

• If a unit or a range related parameter is changed, all the parameters related to both
are changed.

• If an out-of-range value is entered, the input is ignored and the value is restored to
the original. The range is displayed at the bottom of the “Property” control panel.
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• The input format fixed parameter is only editable in the format.

• Values of parameters in “Disable” status are not displayed and the item names are
grayed out.

• In Reading mode, name and value of parameters are grayed out.

• The language of the parameters is not changed regardless of the selected language
when installing the program.
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8. I/O List / DAQ List / Message

8.1. I/O List
After connecting the device, “I/O List” shows parameters for monitoring the added devices.

I/O sources are used to read and control data. To monitor a source listed in the I/O List, you must add
the source to DAQ List.
I/O List shows which units are added to My System. If you click expand button + , it displays a list of
available I/O sources to add. You can search the desired I/O and add it.

1. Double-click or right-click sources you want to communicate, and select Add to DAQ List.
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2. I/O sources are added to DAQ List as below.

Sources added to DAQ List are grayed out in the I/O List. The image below shows
that PV(Present Value), SV(Set Value), OUT Lamp, AL1 Lamp, and AL2 Lamp are
added to DAQ List.

3. To delete added source in DAQ List, select and right-click the source. If you select a source or sources
you want to delete and right-click on mouse, a pop-up menu will appear as below. Then click “Delete
the selected item(s)”, “Remove all” or “Select All” to delete.

I/O source cannot be added to DAQ List in “Run” status.
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8.2. DAQ List
“DAQ List” displays a list of sources added from I/O List.
To add DAQ list, double-click each source, or right-click and select “Add to DAQ list.”
The left side of the control panel shows the number of I/O sources and if select that number, the
devices are rearranged by the signal type.
It is easy to find the general and user-defined tag by the function for searching tag on the right corner of
the “DAQ List”.
When selecting a source in the “DAQ List”, it is possible to check/modify it in Property control panel.
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8.2.1. DAQ List Property
If you select items in “DAQ List” that were added from “I/O List”, “Property” control panel displays item
information, I/O Data calculation and Trigger setting.

1. General

You can change Tag Name, Decimal Point, Unit, and Script variables in General properties and edit Tag
value formulas in I/O Data Calculation.

Device Device name

Address Unit address

Source I/O source name

Tag name Saves tag name as “address_I/O source name” and is changeable.

Decimal point Changes the decimal point of data.

Unit Allows you to change the unit of data.

Script Variable Tag value

Description Allows you to enter the description. (Read/write mode)
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2. I/O Data Calculation

You can get the calculated data by editing formula. “x” is input or output tag value from the device.

Edit Calculation When reading a tag value, apply the data formula to get the desired data.

Trigger Set the event is activated when a tag value matches the user-defined
conditions.

1. Click …  button next to “Edit Calculation” to open “Edit Calculation” window.

2. Click “Templete” at the top-right of the “Edit Calculation” window to edit and save. It is useful to
apply read/write calculation directly.
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3. Enter the desired formular and click the Save  and Apply . The saved template is applied the “Edit
Calculation” dialog box.

4. This function displays the value on DAQMaster or enter the value to device which is calculated from
x. the calcuated output value at DAQMaster or enter a value.

For certain I/O sources, decimal point and unit will be set automatically. In this case,
they conform to the parameter set values.
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8.3. Message
Records events (communication status (start/stop communication, error), log status (start/stop log),
etc.) during running the program.

Messages are saved as *.txt file or log file. Log file is reside in “Message” folder in the installation folder.
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9. RunTime Screen / DAQ Space

This function is for visual data monitoring.
Double-click UI item in “RunTime Screen” to add it to “DAQ WorkSpace”
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9.1. RunTime Screen
Load RunTime Screen

Double-click UI item in the Runtime Screen Library to load to the “DAQ WorkSpace”. The loaded
runtime screen is also displayed in the “Project” control panel.

 

Add I/O sources

Click the I/O source to be monitored in the “DAQ list” window and drag it to the panel of that list in
the runtime screen.
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9.2. RunTime Screen Property
Select the items of RunTime screen in the “DAQ Space” or “Project” control panel, to change the value
of basic parameters in the “Property” control panel.

 

The property parameters have a different option per each item.
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9.3. Grid
Grid displays multiple I/O source data in text for monitoring.
Whenever data is updated in “Run” status, the color of “Time” column inverts.

Edit grid column Right-click the head of grid, “Select Column” dialog box appears. You
can check the desired item to show.

Display updates The color of “Time” column inverts upon updates by checking “Display
When Updated” from the pop-up menu.

Reset Select “Reset Min./Max.” in the pop-up menu to renew the time of data
collection.
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Display alarm If a parameter value causes an alarm, it flashes as below.

The Output by bit Only in case of the device that supports this function, the output data is
represented by bit as below. Double-click the value of a row of “data”
and edit it.
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9.4. Multi panel
It displays I/O source data as Flash type. Multi Panel Viewer can display several I/O source in a screen. If
alarm of parameter value occurs among data (refer to the manual of the device) and it flashes in the set
alarm color.

You can change align mode, color, update interval and etc. in the “Property” control panel by selecting
“Runtime screen – Multi Panel” in the “Project” control panel.

 

Align mode Set the align mode for several I/O source. It supports horizontal,
vertical, horizontal grid align and vertical grid align.

User Alarm Settings Sets user alarm option to the user-defined items

The other settings are same as “Panel graph”. Refer to the  9.5, “Panel”
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9.5. Panel
Panel displays a I/O source data in character. A Panel can display one I/O source only. If a parameter
value causes an alarm (refer to the manual of the device), it flashes as the set alarm color.

Select Panel on the runtime screen in the “Project” control panel to modify properties (such as color,
update interval) in the “Property” control panel.
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Configuration

Display Mode You can select Normal or Vector.

• Vector View: It is possible to display by the mapping process of a tag
in SVG file and device tag item. The character property edit is possible
by the SVG editor except the color of background and alarm.

• Normal View: Display 1 information of device tag item, and changing
the color of character is possible through “Normal View Font Setting”
in “Property” control panel.

Update Interval Interval of the panel update.

View Input I/O Show/hide settings of the I/O source list.

Bottom Color Sets the background color of the panel. In case of the SVG file, it is
possible to apply the background color when the name of SVG tag ID is
designated as “DAQMasterSvg”.

Alarm Color The value of the device tag item exceeds the limit, the background color
of the panel flashes as defined alarm color. In case of the SVG file, it is
possible to apply the background color when the name of SVG tag ID is
designated as “DAQMasterSvg” and it is applied when the number of
registered tag item is under 1.

Normal View Font Setting

Unit Font Unit font setting for normal view of display mode.

Value Font Value font setting for normal view of display mode.

SVG file

File name Select registered SVG file list, preview it, and apply it to the “Panel”. Selected
file path saved as a project file of each panel, but the SVG Panel does not
display data if there are differences between save path and actual file path.
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TAG settings

TAG setting is activated when 1 or more tag item of device is registered in “Vector View” mode.
Edit (OBJECT ID & TAG Editor): Mapping the information of text tag and device item is possible in the
SVG file. After mapping is complete, refresh the screen as the information of the actual device item
when connecting the communication. If delete the device tag item of registered panel, related
mapping data is also deleted.

+(Add) The item is created by base on “OBJECT ID”, and it is possible to
connect to value of item

-(Delete) The last added item is deleted.

Clear (Delete all) All items are deleted.

Interlocking SVG file 1. Enter the text ID information in the SVG file to OBJECT ID in the
“OBJECT ID & TAG Editor”.

2. Select the device tag item and type (Value, Unit and Time).
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9.6. Line Graph
Line Graph displays multiple I/O source data as a graph for monitoring.

I/O source list Use the checkbox of “ ” to show/hide the graph.

Change graph color To change the color by each I/O source, double-click the color in front
of the device.

186 　 Autonics | DAQMaster



Save image Save image feature saves the current graph screen as an image.

Save To File Saves in Bitmap (*.bmp) or
Windows metafile (*.wmf).

Save To Clipboard
(Bitmap)

To use this image directly
for other application
program, saves in Bitmap
(*.bmp) file to clipboard.

Save To Clipboard
(MetaFile)

To use this image file
directly for other
application program, saves
in MetaFile (*.wmf) to
clipboard.

Save CSV Saves in CSV file(*.csv).

Graph Settings Graph Settings allows you to change the general Graph environment,
Y Axis Settings, Tool Config, Graph Theme. For the information, refer
to  9.6.1, “Line Graph Settings”.

List List displays or hides I/O source list items at the bottom of the graph.
Whenever click the List button, the graph screen switched between
On and Off mode.

Graph display mode Set the graph display mode. For the information, refer to  9.6.2,
“Line Graph display mode”.

• Set range: Zoom In/Out Mode, Data Analysis Mode, Data Display
Mode
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9.6.1. Line Graph Settings

1. Graph Settings tab

Graph Settings allows you to change the general Graph environment.

Time Axis Settings Sets time (Hours, Min and Sec).

Time Format Sets time expression for the Time Axis (X Axis)

View Point Shows data point when selected (hides data point when not selected).

Point Type Sets point type.

Line Width Sets thickness of the graph line.

Point Sets point size.

View Data Shows data value when selected (hides data value when not selected).

Digital Axis (%) Sets digital axis as a percentage.
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Line Sets displaying or not upper limit, reference, lower limit line. Sets Y
value, color, width and line color of upper limit, reference, lower limit
line.
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2. Y Axis Settings tab

Set Y axis direction and range of each tag.

Left/Right Y Axis Setting Sets the left/right Y axis auto scale, max/min range, and unit of
the selected tag. Sets the inversion of Y axis.

Tag List Shows s list of tag added at the graph.
Selects the tag to be appeared as Y axis.

Left/Right Y Axis Sets the Y axis type (left/right) of the selected tag.
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3. Tool Config tab

You can set the color band to recognize and emphasize the desired range.

Add/Delete/Delete all Adds/Deletes/Deletes all color band.

Band list Displays the added color bands list.

Band name Sets color band name.

Band standard Sets Y axis (left/right) of color band standard.

Start/End range Sets color band’s start/end range.

Transparent Sets color band transparent.

Color Sets color band color.
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4. Graph Theme

You can set the graph theme (text color, grid color, background color).

Graph theme Selects graph theme.

• Set range: Black, White

Data text/Text/Grid/Grid bottom/Bottom According to the set graph theme, sets colors of
data text/ text/grid/grid bottom/bottom
separately.
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9.6.2. Line Graph display mode

1. Zoom In/Out Mode

Zoom controls Zoom In/Zoom Out of the graph.

Zoom In

On the graph, hold left mouse button and drag to lower right-hand
corner to enlarge the selected area.

Zoom Out

On the graph, hold left mouse button and drag to upper left-hand
corner to return to default scale.

Change X/Y Axis

On the graph, hold right mouse button and drag to change
positions of X/Y axes. If the graph is enlarged or X/Y axes positions
have changed, X axis does not automatically move when data has
updated.
The program preserves user-changed graph scale and axes
positions. It considers this as graph analysis mode.

Mouse wheel functions Ctrl + mouse wheel ↑ Decreases X axis

Ctrl + mouse wheel ↓ Increases X axis

Shift + mouse wheel ↑ Decreases Y axis

Shift + mouse wheel ↓ Increases Y axis

Mouse wheel Increases/decreases X/Y axes
at the same time.

9.6. Line Graph 　 193



2. Data Analysis Mode

Shows X axis (Time) and Y axis values of the mouse position on the graph.

3. Data Display Mode

Displays all data values of the mouse position on the graph.
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If any parameter value causes an alarm (refer to the manual of the device), it flashes
as below.
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9.7. Bar Graph
Bar graph displays multiple I/O source data as a bar graph for monitoring.
Added I/O source list items are displayed at the bottom of the graph.

I/O source list Use the checkbox of “ ” to show/hide the graph of each I/O source.

Change graph color To change the color of each I/O source, double-click the color in front
of the device.
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Save image Saves the current graph screen as an image.

Save To File Saves in Bitmap (*.bmp) or
Windows metafile (*.wmf).

Save To Clipboard (Bitmap) To use this image directly for
other application program,
saves in Bitmap (*.bmp) file
to clipboard.

Save To Clipboard
(MetaFile)

To use this image file
directly for other application
program, saves in MetaFile
(*.wmf) to clipboard.
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Graph Settings Graph Settings allows you to change the general Graph environment.

Axis Set Sets the range of Min. and Max. values of the X/Y
axes.

Origin Sets the start value of bar’s Y Axis.

3D View Sets the display status of the bar.

Bar Style Sets the horizontal and vertical styles of the bar.

List List displays or hides the I/O source list at the bottom of the graph. Clicking
the List button toggles item display on and off.
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9.8. Color Map Graph
Color Map Graph displays multiple I/O source data as a color map graph for monitoring.
At the bottom is added I/O source list.

I/O source list Use the checkbox of “ ” to show/hide the graph of each I/O source.

Display graph color Displays the color of the graph according to the value.
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Save image Save Image feature saves the current graph screen as an image. Save
Image dialog appears when Save Image button is clicked. Images can
be saved in “*.bmp”, or “*.wmf” format.

Save To File Saves in Bitmap (*.bmp) or
Windows metafile (*.wmf).

Save To Clipboard (Bitmap) To use this image directly for
other application program,
saves in Bitmap (*.bmp) file
to clipboard.

Save To Clipboard
(MetaFile)

To use this image file directly
for other application
program, saves in MetaFile
(*.wmf) to clipboard.
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Graph Settings

Graph Type Normal Polar

X/ Y Axes set Sets max./min. value of X/Y axes range.

Circle size Sets displayed circle size.

List Shows s list of tag added at the graph. Double-
click an item to set X, Y coordinate (Normal) or
angle and distance (Polar Bar) depending on
graph type setting.

Color Map Sets color map. Color map supports HSV, JET,
HOT, COOL, and GRAY mode.

List displays or hides the I/O source list at the bottom of the graph. Clicking the
List button toggles item display on and off.
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9.9. Gauge Graph
A Gauge Graph can display only one I/O source.
One Gauge Graph represents the only one I/O source.

Save image Save Image feature saves the current graph screen as an image. Save Image
dialog appears when Save Image  button is clicked. Images can be saved in
“*.bmp”, or “*.wmf” format.

Save To File Saves in Bitmap (*.bmp) or
Windows metafile (*.wmf).

Save To Clipboard (Bitmap) To use this image directly for other
application program, saves in
Bitmap (*.bmp) file to clipboard.

Save To Clipboard (MetaFile) To use this image file directly for
other application program, saves in
MetaFile (*.wmf) to clipboard.
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Graph Settings

Gauge Type Sets gauge graph type.

• Setting range: Circle Gauge,
Horizontal Liner, Vertical
Linear, Numeric Gauge, LED
Gauge

Minimum, Maximum, Label
Interval

Sets minimum/maximum
value and label interval
displayed on graph.

TagName Visible Sets display and color option
of tagname.

Green/Red Line Visible Sets display option of
green/red line in graph.

Green/Red Line Setting Sets start/end value of
green/red line.

List List displays or hides the I/O source list at the bottom of the graph. Clicking
the List button toggles item display on and off.
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9.10. Histogram Graph
It divides and displays data by the set update interval and the number of devision.
You can specify the update interval, upper/lower limit and the number of devision at Property.

Save image Save Image feature saves the current graph screen as an image.

Save To File Saves in Bitmap (*.bmp) or
Windows metafile (*.wmf).

Save To Clipboard (Bitmap) To use this image directly for other
application program, saves in
Bitmap (*.bmp) file to clipboard.

Save To Clipboard (MetaFile) To use this image file directly for
other application program, saves in
MetaFile (*.wmf) to clipboard.

List displays or hides the I/O source list at the bottom of the graph. Clicking the List
button toggles item display on and off.
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9.11. Alarm History Grid
Alarm History Grid displays alarm data of I/O source in text for monitoring.
Whenever an alarm occurs in Run status, the alarm list is updated directly.
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9.12. DAQ Space
DAQ WorkSpace displays “Runtime screen” and runs the programs of the functions that the DAQMaster
supports. The DAQ Space shows each UI and program screen.

Settings Right-click “DAQ Space” tab to add or delete the DAQ Space, or change DAQ Space
name.

Switch Click left/right icon(◀/▶) on the upper right side of the DAQ space window to
switch among the different spaces. Click pull-down icon (▼) to select activating
space in the list.
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10. Tool

10.1. Edit ModBus Device
You can add the any modbus device which are not supported at DAQMaster and set and monitor the
property and I/O.

10.1.1. Creating Device File
1. Double-click “Tool” of menu and Edit Modbus executes at DAQ Space.
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2. At Modbus Device File Settings, you can create new device file (*.udv) or load the saved user device
file (*.udv).
Enter vendor name, product name, description, etc. and click “Save” or “Save As” to save the file.

3. “Save” or “Save As” dialog box appears. Enter file name. The save file name is displayed at File Name
of Modbus Device File Settings

4. Refresh Support Device List and check the newly added device.

Refreshing “Support Device List” is only possible when any device is not added to “My
System”
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10.1.2. Adding device properties and I/O

1. Add One

1. Click “Add” at Properties and I/O List” of Edit Modbus and “Add” dialog box appears. Select “Add
One” and click “OK”

2. Set save type and the desired contents at Properties and I/O Edit of Edit Modbus.
In case of add one, set the one save type among category, properties, or I/O.
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3. When save type is “category”, set the category name. Click “Save” and the category is added at the
properties list.

4. When save type is “properties”, set name, read/write type, address, size, value type, etc of properties.
Click “Save” and the properties is added at the properties list.
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5. When save type is “I/O”, set name, read/write type, address, size, value type, etc of I/O. Click “Save”
and the properties is added at the I/O list.

6. To edit the properties and I/O, click the desired one at Properties or I/O List. At the Properties and I/O
Edit, the contents are displayed. After the edit, click “Save”.
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2. Auto Add Multiple

1. Click “Add” at Properties and I/O List” of Edit Modbus and “Add” dialog box appears. Select “Auto
Add Multiple” and below menu is activated.

2. Select save type at “Add” dialog box.
In case of auto add multiple, set the one save type between properties, or I/O.
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3. Set name, read/write type, address, size, value type, etc of properties or I/O for auto add multiple.
Set start number and add number to add multiple properties or I/O.
For example, property name: AL, Start number: 1, Add number: 5, total 5 properties are
automatically added as AL1 to AL5 name.

Set user group which helps to reduce time for reading/writing data for the same group.

4. To edit the properties and I/O, click the desired one at Properties or I/O List. At the Properties and I/O
Edit, the contents are displayed. After the edit, click “Save”.
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10.2. User Manager
Set and manage program feature permissions for each group by adding a login account to DAQMaster
and creating user groups.
Click the Manage Users button on the Tools menu to run it.
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Group List Manages the list of groups The highest administrator group, admin group,
cannot be modified or deleted, and authorites for each group are managed
individually.

Add group

Enter the name of the group to add to the “Group
Name” and click the [OK] button.

Edit group name

In the “Group List” window, select the group to
change and click the [Edit group name] button.
Enter the name of the group to change in the
“Group Name” item and click the [OK] button.

Delete group

Deletes the selected group from the “Group List”.
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Authority Each group can have authority independently. Select the list of groups to modify
in the “Group List” window, and click the check box to set.

User authority management Authority of each user group and
account modification

Change Files Authority to use the “New”, “Open
Project”, “Save” functions in the
“Project - File” menu
(The “Open from List” and “Save As”
functions are available regardless of
this authority.)

Change Property Authority to write parameters on the
device

Change My System Authority to use “My System” control
panel (add and change device)

Change Projects Authority to use “Project” control
panel

Change TAG List Authority to add and delete tags in
the “DAQ list” control panel

Change Runtime Authority to add and delete “Runtime
screen”
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User Manages user accounts.

Add User

Enter the information for the user account to add and click
the [OK] button.

Edit User

In the “User” window, select the user account name to
change, and click the [Edit User] button. Enter the changes
and click the [OK] button.

Delete User

Deletes selected user account in the “User” window.
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1. Log in

To log in, click the [Login] button in the upper right corner of “DAQMaster” window to open the Login
window, enter ID and password, and click the [OK] button.

Default ID and password of the administrator account are “admin”.
The following message pops up when performing an action without authority. Please
log in again

2. Log out

To log out, click the [Logout] button in the upper right corner of the “DAQMaster” window.
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10.3. Script Editor
With Script Editor, it is possible to use and add the any device which is not supported by DAQMaster,
and analyze inpout/output data.

1. Click [Script Editor] in “Tool” menu to execute “Script Device Editor”.

2. On the top of “File” menu,. click [Open] to open the file to edit or click [New File] to create a Script.

3. The “Function” window at the right side of screen shows the list of functions that are being used.
Double-click the function name to move that location.
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4. Click “Script Reference” tab on the bottom of the screen, “Script Reference” window is activated and
provides list of script reference supported by the script editor. (The supported scripting language is
C, JS, Basic, and PAS.)

5. Click [Check] on the top of “Compile” menu whether scripting language has error or not. When errors
are detected in the scripting language, output window shows the details about error and leads you
to the error location.

If checking is over without error, modified script language is loaded automatically and is ready to use
when running DAQMaster.
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11. Data Analysis

With this program, it is possible to analyze monitored data files (*.duf) through Grid, Graph, Alarm Grid
andd Analysis Spread.

You can run the data analysis program by clicking the Tool › Data Analysis button or in Project ›
Connect › Run › Log › View Log.

Menu Menus are displayed by category. Select a menu to display sub-menus.

Data File It consists of Project, Data file, Analysis Window,
and Analysis Space. For the information about
Data File, refer to  11.1, “Data File”.

Database This menu is available only for DAQMaster Pro
version. For the information about Database, refer
to  11.2, “Database”.

View It consists of View and Window Aligh. For the
information about View, refer to  11.3, “View”.

Help Information for DAQMaster data analysis program.

File List Shows a list of project files to analyze.
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Analysis Window Shows items at the Analysis Space.

DAQ List Shows I/O source list is saved in the data file.

DB List Shows DB list.

Analysis Space Space for displaying data grid, data graph, Alarm Grid.

Data Grid Shows I/O data as grid data.

Data Graph Shows I/O data as graph data.

Alarm Grid Shows alarm data as grid data.
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11.1. Data File

1. Project

New Initializes the opened Data file and the analysis screen.

Open Opens the saved data file (*.dap).

Save Saves the opened data file or analysis windows.

Save As Saves the opened data file or analysis windows as other file name.

2. Data File

Open Opens DAQMaster log file (*.duf, *.krd, *.t5d)

3. Analysis Window

You can add the items (grid, graph, alarm grid) for displaying Analysis Space. For the information about
Analysis Window, refer to the  11.1.1, “AnalysisWindow”.

4. Analysis Space

You can add and delete a tab, or change the tab name at the Analysis Space.
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11.1.1. AnalysisWindow

1. Grid

Analyzes I/O data in grid. Drag the I/O source from the DAQ List and drop onto the data graph screen to
analyze it. The file can be saved as a different file name in *.txt, *csv, *.html or *rtf formats.
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2. Graph

Analyzes I/O data in graph. (X Axis: Time / Y Axis: Value)
Drag the I/O source from the DAQ List and drop onto the data graph screen to analyze it. Right-click to
set the display setting of graph.

 
You can use zoom with the mouse wheel feature on the data graph screen for analysis.
Click on the desired value on the graph, the label (time, data value) is fixed.
Right-click the label, it will be deleted.
When printing, the fixed label is also printed.
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Graph Settings Set Name, Time Axis Settings, Time Filter, Line, Y axis, Legend position,
include date etc.
When the time filter is set, only data for the desired time period can be
output.
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3. Vertical Graph

Analyzes I/O data in graph. (X Axis: Value / Y Axis: Time)
Drag the I/O source from the DAQ List and drop onto the data graph screen to analyze it. Right-click to
set the display setting of graph.

 
Use ctrl + mouse wheel to zoom in and out for analysis on the graph screen.
Click on the desired value on the graph, the label (Time, Data value) will be fixed. Right-click the label,
it will be deleted.
When printing, the fixed label will be printed together.
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Graph Settings Set Name, Time Axis Settings, Time Filter, Line, X axis, Legend position,
include date etc.When the time filter is set, only data for the desired time
period can be output.
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4. Multi Graph

Analyze I/O data using individual graphs. (2 to 6 ea)
Drag the I/O source to analyze from the DAQ List and drop onto the list or drop them directly onto the
graph at the desired location. Double-click the Graph Number and the display setting of graph menu
appears.

Click on the desired value on the graph, the label (time, data value) is fixed.
Right-click the label, it will be deleted.
When printing, the fixed label is also printed.
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Graph Settings Set the Max Charts, Time Axis Settings, Time Filter, and Tag setting.When
the time filter is set, only data for the desired time period can be output.
Change the position of the graph or display multiple data on one graph by
changing the graph number in the tag settings.
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5. Alarm Grid

Analyzes alarm data in grid. Drag the alarm source from the DAQ List and drop onto the data graph
screen to analyze it. The file can be saved as a different file name in *.txt, *csv, *.html or *rtf formats.

6. Analysis Spread

This function is for KRN100, KRN1000.
Analyzes tag values in spread. Displays data with in designated range, which is set by users.

• Save Image: Saves the current graph screen as an image in Graph or Vertical Graph.

• Print: Click the [Print] button to print the analysis screen in Grid, Graph, Vertical
Graph, Multi Graph or Alarm Grid.
If there are fixed labels, they are also printed.
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11.2. Database
This menu is available only for DAQMaster Pro version.

1. Connect

You can check the data of connected database.

2. DB Chart

It displays database data as grid or graph via field setting, etc.
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11.3. View

1. View

Opens file list, analysis window, DAQ List at Data Analysis.

File List Shows a list of opened Data Files (*.duf).

Analysis Window Shows items at the Analysis Space.
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DAQ List DAQ List shows I/O source list saved in the data file. I/O sources can be
analyzed through the analysis screen.

Select I/O source on the DAQ List screen, then drag and drop onto the
Data Grid, Data Graph, Alarm Grid.

2. Windows Align

Aligns analysis windows. Select Tile Align, Horizontal Align, or Vertical Align according to the
environment.
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11.4. Help

Information for DAQMaster data analysis program.
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Appendix A: Autonics TMH Series Special
Features

A.1. Modules scan
For scanning and connecting control/option modules of TMHC, click [Scan] in “Use Module List“.

If [Scan] is not activated, click the [Disconnect] to disconnect and re-connect the
module.
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A.2. Mac Address
Check Mac address of Ethernet module (TMHC-22E) via DAQMaster.
(Mac address is the network address for Ethernet communication)

1. Connect the TMH device with the DAQMaster to check the Mac address.

2. Find the Mac address [Property - Mac Address] on the right side.
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A.3. Parameter User Group Setting

A.3.1. Control / Option module
This feature is able to set the frequently used paramters to the user parameter group. You can quickly
and easily set parameter settings.
The user group parameters of PLC ladderless module are configured sequentially and consecutively in
the device, so it can improve efficiency of communication with the master device via batch read/write
process.
For the information about communication address, refer to manual for communication.
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1. After “Read All Unit Parameters” ,double click the name or click …  button at “User Group” of the
lowermost “Property” control panel to run UserGroup parameter.

2. Select the parameter to add the user group and double-click it or click > . Set the user group number
and click Ok .
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Station Displays unit address.

Model Name Displays model name of the device.

Channel In case of multi channel model, displays channel number.
In case of none channel model, displays ‘NONE’.

Category Displays parameter category.

Parameter List Displays device parameters as list.
Select the parameter to add the user group and double-click
it or click > .

User Group Parameter List Displays the registered parameters for user group parameter
as list.

No. Order of user parameter in device.

User User parameter name of device.

Address User parameter address of device.
Select the parameter to delete the user
group and double-click it or click the <
button.

Clear Delete all the set user group parameter.

Ok Apply the set user group parameter to module.

Cancel Close the dialog window.

3. After adding all parameters you want, click [Ok] to set user group parameter.

For more information about all address of user group parameter, refer to user manual
for communication.
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A.3.2. Ethernet communication module
1. Scan the using modules refer to the  A.1, “Modules scan”.

2. Right click the module to add user group parameter, and click [Read Parameter] button.
It is possible to read parameters of all connected modules by clicking [ReadAll] button.
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3. After selecting the module to add user group parameter, double click "Property" [User Group] or
click …  button to open "User Group Parameter Setting" window.

4. Select the parameter to add to user group, and double click the name or click >  button. To add the
parameter of other station number, close the setting window, select the module in “TMH-C” window,
and enter the setting window again.

A.3. Parameter User Group Setting 　 243



Station Displays unit address.

Model Name Displays model name of the device.

Channel In case of multi channel model, displays channel number.
In case of none channel model, displays ‘NONE’.

Category Displays parameter category.

Parameter List Displays device parameters as list.
Select the parameter to add the user group and double-click
it or click [>].

User Group Parameter List Displays the registered parameters for user group parameter
as list.

No. Order of user parameter in device.

User User parameter name of device.

Address User parameter address of device.
Select the parameter to delete the user
group and double-click it or click the
[<] button.

Clear Delete all the set user group parameter.

Ok Apply the set user group parameter to module.

Cancel Close the window.

5. After adding all parameters you want, click [Ok] to set user group parameter.

For more information about all address of user group parameter, refer to user manual
for communication.
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A.3.3. PLC ladderless communication module
1. Scan the using modules refer to the  A.1, “Modules scan”.

2. To add user group parameter, click [User Group Parameter Setting] button at the bottom of “TMH-C”
– “User Module List” window.

3. Double click the name of parameter to add to “User Group Parameter List”
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User Group Parameter List Displays the list of user group parameters which
is added from “Parameter List”

Total User Group Parameter Number Displays a number of user group parameters
which are added from “Parameter List”

Expands or collapses all the list of user group
parameter list.

Deletes the selected parameter in “User Group
Parameter List”.

Deletes all the parameters in “User Group
Parameter List”.

User parameter Displays information for user parameter.

R/W Displays read/write availability of user parameter.
R: Read, W: Write, R/W: Read/Write

Address Displays address of user parameter.

Parameter List Displays additional parameters of connected
modules.
Double click the parameter name to add “User
Group Parameter List”.

Ok Apply the set user group parameter to module.

Cancel Close the window.

4. After adding all parameter you want, click [Ok] to set user group parameter.

For more information about all address of user group parameter, refer to user manual
for communication.
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A.4. Firmware Version
If the firmware versions of connected modules are different, extra settings are needed for normal
operation. Refer to below details to check the firmware version and change the settings.

A.4.1. Major changed firmware version

Control module TMH2/4

Version 2.00 • Added control output "RUN/STOP" setting when Alarm output

• Added initial operation “RUN/STOP” setting when power is ON.

• Added alarm output RESET "NO/YES" setting

Version 3.01 User group 30EA → 60EA

Communication module TMHC-22L

Version 1.04 • Adds PLC protocol

◦ MELSEC3(QnA-compatible 3C frame (format 4))

• Added TMH4/2 additional parameter activation settings (TMH4/2 Version
2.00 or higher)

◦ Initial operation when power is ON [OFF / ON]

◦ Control output when alarm occurs [OFF / ON]

◦ Alarm reset [OFF / ON]

Version 3.01 • Added dynamic/static allocation function

◦ For versions below Version 3.01, only dynamic allocation is applied.

• Add user group (TMH4/2 Version 3.01 or higher)

◦ TMH4/2 User group setting 30EA → 60EA
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Communication module TMHC-22E

Version 1.04 Added KeepAlive function (0: Disabled, 1 to 3600 sec)

Version 1.05 • Added control output "RUN/STOP" setting when Alarm output

• Added initial operation “RUN/STOP” setting when power is ON.

• Added alarm output RESET "NO/YES" setting

Version 3.01 • Added UDP broadcast function (IP scan using Ethernet cable)

• Add user group (TMH4/2 Version 3.01 or higher)

◦ TMH4/2 User group setting 30EA → 60EA
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A.4.2. Setting by firmware version combination

(1) When connecting control module TMH2/4 [SW version 200] or over to
communication module TMHC-22LE(Old model) [SW version 103] or under

The 3 parameters (POWER ON RUN/STOP, ALARM OUT RUN/STOP, ALARM RESET) which are added in
TMH2/4 [SW version 200] must be disabled.

The system using TMHC-22LE [SW version 103] or under cannot use the 3 parameters
which are added in TMH2/4 [SW version 200].
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1. Scan the using modules refer to the  A.1, “Modules scan”.

2. Select TMH2/4 module SW version 200 or over in “TMH-C” window.

3. Change the value of “POWER ON RUN_STOP, Alarm Out RUN_STOP” to “STOP” and “Alarm Reset” to
“NO” in “Property” control panel.
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(2) When connecting control module TMH2/4 [SW version 104] or under to
communication module TMHC-22LE(Old model) [SW version 104] or over

The 3 parameters (POWER ON RUN/STOP, ALARM OUT RUN/STOP, ALARM RESET) support function of
TMHC-22LE must be disabled.

1. Scan the using modules refer to the  A.1, “Modules scan”.

2. Select TMHC-22LE module SW version 104 or over in “My System” window.

3. Change the value of “POWER ON RUN_STOP, Alarm Out RUN_STOP” and “Alarm Reset” to “Disable”
in “Property” control panel.
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Appendix B: Autonics TN Series Special Features

B.1. Step setting for pattern
In case of program control mode, set steps for each pattern. It is available to set the SV (set value) and
time for each step by clicking the desired coordinates in the graph or directly from the step list.
It can be set in STEP in the parameter Pattern Config group. Click the right …  and the TN Series Step
Setting dialog box appears.
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Refresh Returns to the changed data.

Load Loads saved Step group information file (*.pau) data.

Save Saves the current data as a Step group information file
(*.pau).

Write Writes the current data to the connected device.

Pattern group and parameters You can set parameters (repeat number, End state, PID) for
each pattern group.
If the current device is in RUN mode or if step setting is
made without reading all parameters, pattern group
cannot be set.

Graph Settings Click the coordinates for each step, and it is available to
check/add/edit (shortcut key F2)/delete in the step list.

Add mode Click the X-axis: Time (minutes), Y-
axis: SV (Setpoint) coordinates in
the graph to set the step.

Move mode Click-drag the coordinates of the
set step to edit the coordinates.
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B.2. PLC setting
In case of PLC ladderless communication, you can set PLC monitoring/writing parameters.
It can be set in PLC Group within the parameter PLC group. Click the right …  and the PLC setting dialog
box appears.
Click each parameter to add it in PLC monitoring/writing parameters.

PLC monitoring A total of 16 parameters to be monitored in PLC can be set.

PLC write parameters A total of 38 parameters to be written in PLC can be set. Non-
writable parameters are displayed in grayscale.

Reset/↑/↓ Resets by deleting all set parameters or changes the order.

Write Writes the current data to the connected device.

Save Saves the current data as PLC group information file (*.pap).

Open Loads saved PLC group information file (*.pap) data.
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Appendix C: Autonics DS/DA-T Series Special
Features

DS/DA displays I/O source value, unit, and user set value by DAQMaster.
Connect DAQMaster and DS, DA(RS485 input type) and click … button located on the right of Setting at
Config in the “Property” control panel. A display unit screen is open at DAQ Workspace.

Double-click a monitoring screen of a display unit screen at DAQ Workspace and Setting dialog
appears.
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C.1. DPU Setting

NUM Set the number of display units. Set range is 1 to 24.

Line Mode Displays the added sources of list at the connected display units in a
line.

Overlap Mode Displays the added sources of list at the connected display units by
overlapping at the set interval time.

Overlap Interval Activated for overlap mode. Set the interval time for overlap display.
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Display parts Displays the connected display units and sources in the set color.
Right-click this part to select the segment.

When selecting unit segment, Unit Type dialog box appears to select
the unit display mode.

Add Date/Time Select one of date and time information types.

Add User Display Add the desired characters.
Enter the characters at Source of DPU Data.

Del Delete the added source of list.

List Displays the added I/O sources.
Add I/O sources by dragging them at DAQ list.
Press “Ctrl+↑ or ↓” to change the order of sources.
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Data

Display type

IO Source Displays the value of the source.

IO TagName Displays the name of the source.

IO Unit Displays the unit of the source.
Text Align: Sets the alignment at the
display units.
Source: Displays the name of I/O source
and it is editable.
Num: Sets the desired number of display
units.
Save: Saves the settings.

7 Segment Data Type Sets the display type for H, I, J, K, N, O, T, X characters.

DPU Update Interval Sets the update interval for data value.

Color Sets the displayed color at run time screen.
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Example of adding two date/time sources, overlap mode and 2000ms of overlap
interval.

It displays 2012-04-13 for 2 sec.(2000ms) at first then displays 03:20:06 PM for 2 sec.
alternately.
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Appendix D: Autonics DS/DA-C Series Special
Features

DS, DA-C model synchronizes time, checks world times and sets the summer time via DAQMaster.
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Add

Input Display Name Set the clock name to display.

Select Standard Time Select the time zone based on the
coordinated universal time (UTC).
Select the set time zone of display
unit (DS-C Series).

Summer Time Select the summer time (+0:30,
+1:00, -1:00, -0:30) to apply. If not
applying summer time, select ‘Not
Apply’.

Summer Time Start(End)
Month/Day

Set the summer time period.
Summer time starts from the set
start month/day to the set end
month/day.

Summer time starts August 1st and ends August 31st,
Summer time applied from 00 hour 00 min, August 1st to 24 hour 00 min, August 31st.
Next day, 00 hour 00 min, September 1st, summer time is not applied automatically.
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Edit/Delete

Select Clock Select the added clock to edit or delete.

Detail Setting Data Edit the clock as same method with adding
clock.

Clear Clear (delete) all added clocks of the Clock space.
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Appendix E: Autonics SCM-WF48 Series Special
Features

Communication setting of SCM-WF48 is editable with DAQMaster.

E.1. Differences and method of distinction between new and
old models

1. Difference between new and old models

Based on the manufacturing date, the products produced after September 2019 are new model and the
products produced before are old model. Firmware upgrade is only available for old model.
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2. Method of distinction

After connecting the device, it is possible to check the text at the top right of the “SCM-WF48 Config”
window. This is the old model if the firmware version statement appears, as like “S2W APP
VERSION=X.X.X.” and a new model if only the product version appears, as like “V X.X.XX”. Refer to the
image below.
Old model

New model

• For more information about connecting devices, refer to the “Connecting device”
chapter below.

• For more information on the differences between old and new products, refer to the
contents at Autonics website (www.autonics.com).
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E.2. Connecting device
You can connect SCM-WF48 to DAQMaster in manual mode or auto mode.
Connect DAQMaster and SCM-WF48 after setting communication mode to USB with USB/485
communication mode switch on the side of the SCM-WF48 device.
Double-click SCM-WF48 in My System to open SCM-WF48 Config tab in DAQ Space.

1. Manual connection

Enter the port, baudrate, byte size, parity, stop bit values in the upper side of the SCM-WF48 Config tab
equal to SCM-WF48 device and click Connect .
Followings are default values of SCM-WF48.

Baudrate 9600

Byte Size 8

Parity None

Stop Bit 1

2. Auto connection

Click Auto Search  to open “Auto Search” dialog.
If you select items to search and click Search  button, DAQMaster displays accessible SCM-WF48.
When PC is connected with over 2 SCM-WF48 devices, DAQMaster is automatically connected with first
SCM-WF48 in numerical order of port number.
In “Version” window, it is possible to select what version to search for. Check the desired version of
“Old” (old model) or “New” (new model) and click the Search  button.

E.2. Connecting device 　 269



E.3. Setting communication mode
Select communication mode of SCM-WF48 from AP mode and Station mode.

1. AP mode

SCM-WF48 performs as AP (access point).
PC, smart phone, PLC are connected directly with SCM-WF48 using Wi-Fi to communicate with other
devices which are connected to SCM-WF48 with RS485 wired connection.

1. Click “AP Mode” to operate AP mode setup wizard.

2. Set Wi-Fi generation.

AP name Sets displaying name.
Default is SCM-WF48AP.
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Channel Sets Wi-Fi frequency. (setting range: Auto, 1~14)
If the number of channel is same or next to each other with another wirelessly
connected devices, communication interference occurs and makes
communication status unstable.

Static IP Sets IP, Mask, Gateway as follows.
Please check network environment ahead of setting.

IP 192.168.1.1

Mask 255.255.255.0

Gateway 192.168.1.1

3. Set Wi-Fi authentication.

Followings are types of authentication.

Type Description

Auto Selects mode of authentication automatically.
Passphrase is required for connection.
If you enter passphrase at the first time, DAQMaster connects
automatically without passphrase.

Open Selecting SSID connects AP, without passphrase.

PWA WEP Encrypts connection and communication.
In order to strengthen security, PWA mode is recommended.
Passphrase is required for connection.
Order of security safety: WPA2TKIP > WPA2AES > WPAAES, WPA2 > WPA
> WEP

WPA

WPA2

WPAAES

WPA2AES

WPA2TKIP
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4. Set Wi-Fi protocol.

Protocol Select Wi-Fi protocol from TCP, UDP.

Mode “AP mode” only supports Server mode.

Port A set of server and client has set in same port value.
(In Modbus communication, 502 port is used in general)

5. Set UART.

Enter the Baudrate, Byte Size, Parity, Stop Bit values equal to the device which is connected to SCM-
WF48 device with RS485 or USB and click “Write”.
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6. On the SCM-WF48 Config tab, setting values are displayed on the left side and progress for
connection is shown on the right side.
When applying setting values is completed, message saying “Write OK!” pops up.

7. AP mode setting is finished.
Please reboot SCM-WF48 device in order to apply setting values to the device.
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2. Station mode

SCM-WF48 is linked to another AP.
Wireless router and SCM-WF48 is connected using Wi-Fi therefore PC, smart phone, PLC connected to
wireless router can communicate with other devices which are connected to SCM-WF48 with RS485
wired connection.

1. Click “Station Mode” to operate Station mode setup wizard.

2. Set Wi-Fi generation.

AP name Sets displaying name.
Default is SCM-WF48AP.

AP Scan Scans AP.
When scanning AP, it may be necessary to repeat again.
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MAC select/address Check the “MAC select” and you can enter MAC address.
When the same SSIDs exist, enter the MAC address and connect the
desired SSID.

Channel Sets Wi-Fi frequency. (setting range: Auto, 1 to 14)
If the number of channel is same or next to each other with another
wirelessly connected devices, communication interference occurs
and makes communication status unstable.

IP Selects IP from DHCP and Static IP.

DHIP DAQMaster sets IP automatically.

Static IP User sets IP manually.

Static IP Sets IP, Mask, Gateway as follows.
Please check network environment ahead of setting.

IP 192.168.1.1

Mask 255.255.255.0

Gateway 192.168.1.1

3. Set Wi-Fi authentication.

Followings are types of authentication.

Type Description

Auto Selects mode of authentication automatically.
Passphrase is required for connection.
If you enter passphrase at the first time, DAQMaster connects
automatically without passphrase.
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Type Description

Open Selecting SSID connects AP, without passphrase.

PWA WEP Encrypts connection and communication.
In order to strengthen security, PWA mode is recommended.
Passphrase is required for connection.
Order of security safety: WPA2TKIP > WPA2AES > WPAAES, WPA2 > WPA
> WEP

WPA

WPA2

WPAAES

WPA2AES

WPA2TKIP

4. Set Wi-Fi protocol.

Protocol Select Wi-Fi protocol from TCP, UDP.

Mode Select Mode from Server and Client.

Server SCM-WF48 operates as server.

Client SCM-WF48 operates as client. Connecting information of
server is required.

Server IP Enter server IP.

Port A set of server and client has set in same port value.
(In Modbus communication, 502 port is used in general)

5. The other settings are same as AP mode.
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3. Advanced settings

Set network communication at once without setup wizard.
You can save/ load/save as the communication settings.

Notes for SCM-WF48 communication setting

• Single Wi-Fi network needs at least one AP.

• Single network consisting of wire and wireless connection needs at least one DHCP
server.

• At least one set of server and client is necessary.
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E.4. Utility
“UART Settings”, “Reset Factory Default”, “Profile” allows you to check or edit the setting value.

UART Settings You can check or edit VCP(USB), RS-485 communication setting
values.

Reset Factory Default Initializes Baudrate, Byte Size, Parity, Stop Bit of SCM-WF48 to its
factory default settings.
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Profile Displays Wi-Fi setting information of SCM-WF48.
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E.5. Firmware version upgrade
After connecting SCM-WF48, you can check the firmware version and upgrade it at top-right of SCM-
WF48 Config tab.

Firmware version upgrade is only available on old versions of SCM-WF48.
It is needed to be connected to the wireless LAN and the Internet.

1.
Click the  icon.

2. The dialog for firmware version upgrade appears.
Click the OK  button.
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3. The “Firmware Upgrade” dialog box appears.

Wireless network connection of PC sets as OTA and click OK .

4. It connects to “OTA Firmware Update”.

Add the SCM-WF48 firmware which is downloaded at Autonics web site.
Click the Upload  button.

5. Firmware upgrade is completed.
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Appendix F: Autonics KRN50 Series Special
Features

F.1. Accessing Record Backup Data
To get the recorded data, click …  button located on the right of Record Backup in the “Property”
control panel.
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To read memory information, the device status must be Connected and not Run.
There are also cases in which you cannot read from memory depending on KRN50 parameter setting.
(Refer to “KRN50 user manual”.)

Once all conditions are met and ready to get memory data, follow the steps below:

1. Run [Memory Information] in KRN50 Record Memory Data window. It gets the information from
currently saved memory.

2. Set [Uploaded Data Size].

3. Run [Upload Data].

4. You can cancel the operation while data is being uploaded. When data reading is complete, OK
button is enabled.

5. If you click OK , recorded data will be shown in two screens - the Grid and the Graph.
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F.2. Downloading User Images
User Image allows you to download images to KRN50 and change logo, unit and boot images.
You can also reset images back to the original status. This is also a self protocol, so cannot download
images during Run.

Download logo You can change the company logo image on contents that are
printed on recording paper.
Logo image should be 384 X 80 pixel of bitmap file.

Download Units There are 0-9 user units.
The download procedure is: select a unit list → select a
destination to save → double-click a unit image to add the image
→ download.
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Download boot images The boot image (logo image) appears on LCD upon initial power
supply to KRN50.
You can change booting logo image which displays when KRN50 is
power ON.
The image should be 128 X 32 pixel of bitmap file.
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Appendix G: Autonics KRN100 Series Special
Features

G.1. Accessing Record Backup Data
It is available to access saved backup data of KRN100 and to analyze backup data by data analysis
feature.
To get the recorded data, click …  button located on the right of Record Backup from User Memory in
the “Property” control panel.

According to the USER INFORMATION SETUP of KRN100, it cannot read the memory. (Refer to the user
manual for KRN100.)
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1. Designate the folder for record backup data to be saved.

2. Select the record backup data to download. Click the right mouse button and select “Download Log
File”.
Double click the backup data and it enters to data analysis.
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3. After completing download to the designated folder, the below message appears.
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G.2. Downloading User Images
You can add user unit and boot images of KRN100.

Download units There are 0-9 user units.
The download procedure is selecting User Unit Position, double-
click Small Unit, Middle Unit, Big Unit image, and selecting the
image. After this, Download button is active.

Download boot images The boot image (logo image) appears on LCD upon initial power
supply to KRN100. You can change booting logo image which
displays when KRN100 is power ON.
The image should be 320×120 pixel of bitmap file.
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Appendix H: Autonics KRN1000 Series Special
Features

H.1. LogData Backup
You can download backup data which is saved in KRN1000 internal memory from “Record Backup”
section.
To get the backup data, click …  button located on the right of 'LogData Backup' from User Memory in
the “Property” control panel.
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Directory form is year, month, day. Click the relevant icon and check below list.
To download backup file, click the file name with right mouse button and select “Download Log File”
menu.

Backup files are structured as tree type directory at KRN1000 internal memory. You can easily fine and
download the desired file.

If there is an error in the backup file, the Start and End Time are displayed as
'0000.00.00 00:00:00'.
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Appendix I: Autonics ARIO Series Special
Features

You can easily read and set information for the ARIO series couplers and modules using DAQMaster.
It also allows you to control the input/output signals of each module and offers a function that lets you
virtually configure ARIO units and conduct simulations without having to physically connect the actual
products. For information on the dedicated functions of the ARIO series provided by DAQMaster,
refer to the table below.

Communication mode

You can use the following functions when the DAQMaster and ARIO unit are properly connected

through Run › Connect in the top menu of DAQMaster. Before using the function, check whether the
communication between DAQMaster and ARIO unit is working properly.

Function Access path

Property & parameter setting Module › Click coupler/module image › Property window ›
Protocol item

Input & Output signals control Module › Click module image › Property window › I/O setting
item

Input & Output signals monitoring Run › I/O Monitor

Tag monitoring I/O List › ARIO Config › Tag
Check & save address map AddressMap

Coupler firmware update Module › Click coupler image › Property window › Protocol

item › System configuration

Virtual mode

Function Access path

ARIO system configuration Module

Check & save address map AddressMap
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I.1. Communication Mode

I.1.1. Connection
1. Connect the USB port of the device with DAQMaster software installed to the CONFIG port of the

ARIO coupler using a USB cable.

2. Double click Supported Device List › AUTONICS › ARIO Config in DAQMaster.
The list of ARIO Config devices is added to the ‘My System’ window at the bottom left of the screen.

3. When you click  scan button in the ‘ARIO Config’ window, the connected ARIO unit appears on the
screen. At this time, check whether the communication mode is applied.

4. Click Run › Connect button in the top menu to enter the communication connection state.

Even if the connection status between DAQMaster and the ARIO unit is normal, there
may be cases where the unit’s information does not update.
In such situations, you can update the unit’s information by turning off and on the
power to the ARIO unit, and then clicking  scan button in DAQMaster.
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I.1.2. Property and parameter setting
You can use DAQMaster to set the property and parameter value supported by ARIO couplers and
modules.

Device selection and parameter setting

1. In the ‘ARIO Config’ window, click  Module button to open the Module tab.

2. Select the desired coupler or module. In the ‘Property’ window on the right side of the screen,
you can see the current property information or parameters of the device and modify the values as
necessary. For more information about modifiable properties and parameters, refer to the manual
for your product.

◦ Coupler: Check [Protocol] item in the ‘Property’ window.
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◦ Module: Check [Data] item in the ‘Property’ window.

Property change detection

1. When a property item of a coupler or module is changed, a guidance message to restart the ARIO
unit will appear. It will be displayed above the coupler image in the format [Setting changes. Please
click here.].

2. Click the guidance message to proceed with the reset. After the reset is complete, click  Scan
button again to apply the changed information.
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I.1.3. Input and output signals control
You can control the input and output signals of connected modules.

1. In the ‘ARIO Config’ window, click  Module button to open the Module tab.

2. In the Module tab, select the module to control input or output signal. Check the [I/O Setting] item
in the ‘Property’ window on the right side of the screen.

3. For example, to set the output signal to ON for a specific channel on an output module, select the
module and enter the value for the desired channel. After you complete the setting, you can verify
that the output signal is ON through the channel indicator LED on the module.

When you enter the signal value, consider the ‘Expression (binary, decimal,
hexadecimal)’ and enter the correct value.
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I.1.4. Input and output signals monitoring
You can monitor the input and output signals of connected modules in real time.

1. Click Run › Run button in the top menu.

2. Click  I/O Monitor button in the ‘ARIO Config’ window to open the I/O Monitor tab.

3. You can monitor input and output data sorted by Channel or Address by clicking [Sort] button at the
top right of the screen.

◦ Sorted by channel

◦ Sorted by address

Input and output signals control

1. On the  I/O Monitor screen, set the sort by channel to control the input/output signals of the
module.

2. After selecting the desired module, click the Data cell or press F2 and enter the value.

When you enter the signal value, consider the ‘Expression (binary, decimal,
hexadecimal)’ and enter the correct value.
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I.1.5. Tag monitoring
You can visualize and monitor the data from connected modules in real time.

1. To establish a communication connection between DAQMaster and ARIO unit, click Run › Connect
button in the top menu. And then in the ‘ARIO Config’ window, click  scan button to load the
connected ARIO unit.

2. To check the module configuration of the connected ARIO unit, select I/O List › ARIO Config.
Double click the channel you need to monitor.
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3. As shown in the figure below, the selected channel is added in the form of a tag
in the ‘DAQ List’ window.

4. To configure the visualized monitoring screen, double click RunTime Screen › Data › (example) Multi
Panel.
The multi panel appears in the ‘DAQ Space’ window.

5. Drag and drop the tags added to the ‘DAQ List’ window into the tag name area of the multi panel.
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6. You can monitor the status of the tag in real time by clicking Run › Run button in the top menu.

I.1.6. Address map
You can verify the communication address of the connected ARIO unit and save this information to a
file, which can be utilized during the configuration of the ARIO system.

1. Click  AddressMap button in the ‘ARIO Config’ window.

2. The device list of connected ARIO unit is displayed on the left side of the screen, and the
communication address of each device is displayed on the right side.

3. Click [Save] button on the top menu to save it in .CSV or .UDV 01) file format.

01) UDV file format
This is a file format that can only be used in coupler models (ARIO-C-MT / ARIO-C-MR) that support
the Modbus communication. Input and output information can be set or monitored when using the
‘Edit Modbus Device’ function.
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I.1.7. Coupler firmware update
You can update the firmware of the ARIO coupler in DAQMaster.

• When downloading or updating the coupler’s firmware, ensure that you verify
whether the firmware version is v1.20 or v1.30, and select the appropriate file for
that version.

• If the firmware version is v1.20.** or below, upgrading to version v1.30 is not
supported.

• If the firmware version is v1.30.** or above, downgrading to version v1.20 is not
supported.

• If the firmware version is v1.30.** or above, install the latest DAQMaster software
version v3.5.13 or higher.

Online state

1. Establish the communication state between the DAQMaster and the ARIO unit by selecting

communication mode › Connect from the menu, and then click the coupler image in the ‘ARIO
Config’ window.

2. In the ‘Property’ window on the right side of the screen, click …  button of [System configuration]
item to open the ‘System Setting’ window.

3. Click [Firmware update] button in the ‘System Setting’ window to perform the update.

Offline state

1. Download the latest firmware version for the ARIO coupler from our website.
Be sure to keep the downloaded ‘*.zip’ file in its original, unextracted state.

2. Establish the communication state between the DAQMaster and the ARIO unit by selecting

communication mode › Connect from the menu, and then click the coupler image in the ‘ARIO
Config’ window.

3. In the ‘Property’ window on the right side of the screen, click …  button of [System configuration]
item to open the ‘System Setting’ window.

4. Select the version of the downloaded firmware at the bottom of the 'System Setting' window,
then click [Load firmware file] to load the update file (.zip) corresponding to the selected firmware
version.

5. Select the desired version from the ‘Firmware version list’ and click [Firmware update] button to
perform the update.
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Bootloader active state (firmware update failure)

• Maintain the physical connection between the device with DAQMaster installed and
the ARIO unit.

• Always verify the model name of the coupler in use before proceeding with the
firmware update.

• Ensure that the model name selected during the firmware update matches the
actual model name of the coupler being used to avoid potential product damage.

If you are unable to load the information of the ARIO unit, or if the SYSTEM status indicator on the
coupler lights up in orange, follow the instructions below to perform the firmware update.

1. To disconnect from DAQMaster, click Project › Run › Disconnect button.

2. Click [mode] button in the ‘ARIO Config’ window and select Firmware update (when entering boot
loader). The ‘System Setting’ window opens.

3. Select the version and coupler model to be updated from the drop-down menu in [Firmware
version list], and then click [Firmware update] button to perform the update.
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I.2. Virtual Mode
This function allows you to configure an ARIO unit by selecting the desired coupler and module
through 'Virtual Mode', even in the absence of the actual product. It can be utilized during the planning
phase of system configurations.

I.2.1. ARIO system configuration
1. Select Virtual Mode in the ‘ARIO Config’ window.

2. A list of coupler and modules is displayed on the left side of the  Module tab. Double click the
desired coupler and module from this list to configure a virtual ARIO unit.

◦ Delete all: Deletes all added products at once.

◦ Delete: Deletes selected module one by one. Deleting a coupler will delete all added products.
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3. Clicking [Auto alignment] button will align your module configuration with our recommended
module setup. Additional power modules can be added depending on the number of connected
input and output modules.

Check and save the address map

1. Click  AddressMap to check the communication address of the ARIO unit configured by the user.

2. Click [Save] button to save the address map in .CSV file format.
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Appendix J: Autonics B7VA Series Special
Features

This document describes how to configure a playlist on the DAQMaster and save it to a micro SD card
for use with the B7VA Series (external memory model) or as a project file.

J.1. Before You Begin
Before configuring a playlist on the DAQMaster, refer to the table below to prepare the necessary
equipment and audio (sound) files.

Buzzer B7VA Series (external memory model)

Micro SD card BSD-16G

SD card adapter,
SD card reader

If you are using a device without a built-in micro SD card slot, prepare an
appropriate SD card adapter or SD card reader.

DAQMaster device PC or laptop with the DAQMaster software installed

Audio (sound) file Prepare audio files in .mp3 or .wav format for use with the buzzer.

J.2. Property
In case of B7VA-AKD-E model, set the below menus and it applied to all channels.
For more information, refer to the B7VA product manual.

Play mode Set playback mode.
Click the ?  button to check the operation timing chart for each
mode.

• Setting range: A to E mode (default: A mode)

Input mode Set input method. Depending on the set input method, supply the
signal to the desired channel.
Channel range is varied by model or input method. (BIT input: 6
channels / Binary input: 63 channels)

• Setting range: Bit, Binary (default: Bit)
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Volume reduction rate Set volume down rate. Based on the volume control switch (100%),
it plays audio sources at reduced volume while signal is input to
VOL DOWN terminal.

• Setting range: 1 to 100% (default: 80%)
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J.3. Playlist

Audio file list function

 Add Add audio files.

 Edit Modify the properties of the added audio file.

 Delete Delete a file from the audio file lists.

 Delete all Delete all files from the audio file lists.

Playlist function

 Play Play the configured playlist per channel.

 Stop Stop playing the playlist.

 Open Import the saved project file (.scf) into the DAQMaster.

 Save Export the configured playlist for the SD card (.bin) or project file (.scf)
format.
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Convenience

Storage size The storage space occupied by audio files is displayed.
( 0.00 MB / 4.00 MB  )

Screen zoom in / out Zoom in or out the playlist configuration screen.
(  )

 Auto screen aspect ratio The aspect ratio is automatically set to 100%.
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J.3.1. Configure the Playlist

1. Import audio files

1. Double-click Supported Device List › AUTONICS › B7VA Config. The B7VA Config window is created.

2. Click  [Add] button on the audio file lists tab. Select the saved audio file and then click the [Open]
button. A file list will be created on the audio file lists. At this time, the .wav files are automatically
converted to the .mp3 files. Other audio files are encoded depending on the specifications shown in
the table below.

Items Specifications

Compression format LAME

Bit rate 32 kbps

Sampling frequency 24000 Hz

Channel mono

3. If you want to modify the properties of the imported audio file, click the desired audio file.
 [Edit] button on the audio file lists tab is activated.

4. Click  button to open the edit window.
Enter the appropriate value refer to the table below and then click the [OK] button.

Items Setting range

Volume 50 to 150%

High pass filter 0 to 15

Low pass filter 0 to 15
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2. Set a Playback

Channel range is varied by model or input method. 16 audio sources are supported
per channel.
[B7VA-8KD-E] BIT input: 8 channels (up to 128 audio source)
[B7VA-AKD-E] BIT input: 6 channels (up to 96 audio source) / Binary input: 63 channels
(up to 1008 audio source)

1. Drag the audio file from the audio file lists tab.

2. Drag and drop the file by navigating to the channel and audio order you want.

3. When you click the file, you can check or set the items below in the property control window
on the right side of the screen.

Items Access Setting range

Settings Channel RO -

Audio RO -

MP3
properties

File name RO -

File size RO -

Bit rate RO -

Length (duration) RO -

Playback
settings

Playback counts RW 0 to 255 (0: continuous loop)

Playback latency RW 0 to 3600.0 seconds

You can also check the information about the audio source through the UI as shown below.

1: The file name of audio source
2: The number of the audio file lists
3: The value of playback counts
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4: The value of playback latency

3. Play a Channel

1. Shift + click to select a segment of audio sources and click  [Play] button.

2. The selected segment will be played as shown below.

J.4. Export the Playlist
1. When you have completed the playlist configuration, click  [Save] button.

2. (1) To save the playlist on the SD card, select the Playlist for SD card (.bin)    .
(2) To save the configured playlist as a project file, select the B7VA project file (.scf)   .

3. When the file save dialog box appears, select a location to save the file and click [Save] button.

◦ The playlist file for the SD card (.bin) is created with the file name [B7VA-8KD-E
model] B7VA-E_VoiceFile.bin or [B7VA-AKD-E model] B7VA-A_VoiceFile.bin. The
playlist will not be played properly on the buzzer if the file name is modified, so
refrain from renaming the file and keep it unchanged.

◦ When transferring a playlist saved on the SD card to the buzzer, ensure that the
existing .bin file stored on the buzzer is deleted and replaced with the new file.
When transferring it for the first time, the buzzer’s built-in eight alarm sounds will
be deleted.

J.4.1. Import the Playlist
1. Click  [Open] button.

2. When the file open dialog box appears, select the desired B7VA project file (.scf)
and then click the [Open] button.

3. The audio file list and playlist of the project file will appear on the screen.

◦ The .bin file cannot be imported into the DAQMaster after export.
The .bin file is a playlist for the SD card and is intended to be saved in the buzzer.
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Appendix K: Autonics SPRM, SPRS Series Special
Features

K.1. Alarm History
All alarms occurring within 1 minute after the SPRM and SPRS series devices switch from a normal
status (no alarms) to an alarm status (at least one alarm active) are saved.

1. To check the alarm history in the product, click …  button located on the right of Alarm History in the
“Property” control panel.
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2. The alarm history screen for each module type appears.
When the number of alarms exceeds the limit, the earliest record is deleted, and alarms are listed
with the most recent at the top
If an alarm status is 'ON', the corresponding alarm is highlighted in yellow.

SPRM Log Data
Provides alarm history data for single-phase/3-phase/common modules, and it is possible to check up
to 10 log data (Log 0 to 9)

316 　 Autonics | DAQMaster



SPRM Log Alarm Details
For more information about the alarms, refer to the SPRM communication manual.

Module type Alarm Description

Single-phase,
3-phase

OC Overcurrent alarm

OV Overvoltage alarm

LF Heater break alarm

UL Load imbalance alarm

SCR_Short SCR error alarm

FUSE Fuse break alarm

FrQ Frequency error alarm

DLF Partial heater break alarm

Common OT60 Heatsink overheat alarm

OT80 Heatsink overheat protection alarm

FAN FAN error alarm

RUN_STOP RUN / STOP switch

AUTO_MANU AUTO / MANU switch
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SPRS Log Data
Provides alarm history data for single-phase/single-phase dual/3-phase modules, and it is possible to
check up to 50 log data (Log 1 to 50)
'Mode' indicates the wiring method when the alarm occurred, and when selected, it is possible to
check the alarm history for each channel of the selected Mode.
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SPRS Log Alarm Details
For more information about the alarms, refer to the SPRS communication manual.

Alarm Description

OC Overcurrent alarm

OV Overvoltage alarm

HTBK Heater break alarm

UL Load imbalance alarm

SCR_Short SCR error alarm

FUSE Fuse break alarm

Frqy Frequency error alarm

DLF Partial heater break alarm

OTW Heatsink overheat alarm

OTP Heatsink overheat protection alarm

FAN FAN error alarm

LowInPower Input low voltage alarm

PowerModule Module connection error alarm
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